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Welcome | 1

Congratulations on purchasing the Hewlett-Packard
Jornada 820 or 820e Handheld PC (H/PC), a mobile device
powered by the Microsoft® Windows® CE operating
system. The size and capabilities of the HP Jornada 820/
820e H/PC let you keep your most important business and
personal information current and close at hand. Your
HPÊJornada supports the latest version of Microsoft Pocket
Outlook, so you can check e-mail while on the road and
manage your appointments and contacts. You will find that
your HP Jornada is also the perfect companion to your
desktop or notebook PC, allowing you to take vital business
data and documents with you and easily upload updated
information upon returning to the office. HP Jornada offers
you the highest quality in performance and battery life as
well as rich programs and utilities designed by Hewlett-
Packard, making HP Jornada your powerful, reliable,
mobile business partner.

If you are familiar with Microsoft Windows products and
notebook PCs, you will notice that your HP Jornada has
many of the same characteristics, making it easier for you
to be productive quickly.

In this chapter, you will find:

• A list of the HPÊJornada package contents

• An introduction to HPÊJornada features and a descrip-
tion of the advantages of using the HPÊJornada

• Instructions on how to care for your HPÊJornada
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2 | HP Jornada H/PC User’s Guide

Opening the HP Jornada package
Your HP Jornada package includes the following items:

• HP Jornada 820 or 820e H/PC

• HP Jornada Standard Battery

• Two CR2032 coin-cell backup batteries

• AC adapter and power cable

• Sync cable

• HP Jornada Quick Start Guide—A guide to getting
started with your HP Jornada quickly

• Desktop Software for Microsoft WindowsÊCE compact
disc—Includes Microsoft WindowsÊCE Services as well
as software and system updates for both your
HPÊJornada and desktop PC

• HP Jornada compact disc—Includes programs and
utilities that add functionality to your HPÊJornada

• Documentation pack—Includes this User’s Guide and
Regulatory Information Leaflet

• HP Jornada Accessory Guide—Includes information on
accessories and products that can help you get the most
from your HP Jornada

The following optional accessories (and their HP item
numbers) also are available from Hewlett-Packard. Check
the Hewlett-Packard Web site at www.hp.com/handheld
for updates.

• Extended battery (F1276A)—Provides up to 15 hours of
battery life.

• Sync/AC cable (F1268A)—Integrated sync and AC cable
allows convenient one-step connection to your desktop PC.

• CompactFlash Card and adapter (4MB) (F1231A)—Adds
storage memory.
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Chapter 1 | Welcome     | 3

• CompactFlash Card and adapter (10MB) (F1233A)—
Adds storage memory.

• Parallel Printer Cable (F1274A)—Connects your
HPÊJornada directly to a PCL printer.

• Serial adapter (F1295A)—Allows you to connect to the
25-pin port on your desktop PC from the 9-pin connector
on your sync cable.

Using this guide
This User’s Guide is designed to help you use your
HPÊJornada quickly and easily. Although great care has
been taken to ensure the accuracy of procedures and screen
art, some actual screens may be different than the ones
that appear in this User’s Guide. Detailed, step-by-step
instructions for using the programs on your HP Jornada
are also included in online Help, so you’ll always have
access to them, and you don’t have to carry this guide when
you travel. (For more information on using online Help, see
the Using Help on your HPÊJornada section in chap-
terÊ2.)

Contents

This User’s Guide includes the following chapters:

• ChapterÊ1, Welcome—Offers a quick overview of the
HP Jornada package and this User’s Guide.

• ChapterÊ2, Getting started—Provides step-by-step
instructions for installing the batteries, completing the
Windows CE Welcome Wizard, and preparing to use
your HP Jornada for the first time.

• ChapterÊ3, Accessing e-mail and the Web—
Describes how to connect to the Internet or to a corpo-
rate network and how to send and receive e-mail and
browse the Web.
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• ChapterÊ4, Connecting to your desktop PC—
Provides all the information you need to install
WindowsÊCE Services on your desktop or notebook PC,
transfer files, and synchronize Pocket Outlook data and
e-mail messages.

• ChapterÊ5, Staying organized—Explains how to use
your HP Jornada to manage your calendar and address
book and describes to-do lists, alarms, and reminders.
Includes documentation on Pocket Outlook, Microsoft
Voice Recorder, and the HP Jornada viewer application.

• ChapterÊ6, Getting down to business—Describes the
productivity programs included with your HP Jornada:
Microsoft Pocket Office (Pocket Word, Pocket Excel,
Pocket Access, and Pocket PowerPoint) and Microsoft
InkWriter®, the HP Jornada backup and HP Jornada
show applications, bFAX™ Pro and bFIND from
bSquare™, and OmniSolve from LandWare.

• ChapterÊ7, Customizing your HP Jornada—
Details the many ways you can add functionality to
your HP Jornada by installing additional software and
programs and explains how you can customize your
HPÊJornada and the Windows CE operating system
using Control Panel.

• ChapterÊ8, Troubleshooting—Offers helpful tips and
procedures to follow when things do not work quite as
you expected.

• Appendix A, Ergonomic information—Provides
important information about repetitive strain injuries
and how to use your HP Jornada safely and comfortably.
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Conventions

This User’s Guide includes certain visual cues that will
help you find the information you want easily.

A shortcut, another way to do something, or expanded information
about the topic.

Caution or warning information about the topic. This is important
information that should be observed to prevent loss of data or
damage to your HP Jornada.

 Step-by-step instructions.

Helpful information related to the topic.
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Finding information
This guide describes what is included with your
HPÊJornada, provides an overview of the programs in-
cluded, and describes how to set up communications
between your device and desktop PC and between your
device and the Internet. The following table is a guide to
the different types of information available to help you use
your HPÊJornada. Note that, although this book introduces
the programs on your device, it does not describe them
completely. For more information, see the comprehensive
online Help for each program.

Information Source

Programs This User’s Guide.
–or–
Online Help on your device. On the Start menu, click Help.

Synchronizing and exchanging This User’s Guide.
 files with a desktop PC –or–
(including information on Online Help on your device. On the Start menu, click Help.
connecting while traveling) –or–

Windows CE Services online Help on your desktop PC.
In the Mobile Devices window, click Help, and then click
Windows CE Services Help Topics.

Toolbar buttons Click and hold on a toolbar button to see its name. Drag off the
toolbar button before lifting to avoid activating the button.

Troubleshooting information The Communications Troubleshooter on your desktop computer. In
on connections the Mobile Devices window, click Help, and then click

Communications Troubleshooter.

Up-to-date information on The Microsoft Windows CE Web site at
Windows CE–based devices  www.microsoft.com/windowsce.

Information on this release Readme.doc file (located in the Windows CE Services folder on
of Windows CE your desktop PC).

The complete text of this User’s Guide is also available on the Hewlett-Packard Web site at
www.hp.com/handheld. You can download the User’s Guide to your desktop PC and view it
using the Adobe™ Acrobat Reader, available from the Adobe Web site at www.adobe.com.
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Learning about HP Jornada
Hewlett-Packard has taken mobile computing to new levels
of compatibility and convenience. With HP Jornada, you’ll
notice many benefits that you would not find using other,
similar computers. Your HP Jornada is:

• Ready to work when you need it, with up to 10 hours
of battery life

• Simple to synchronize with your desktop PC
• Convenient to carry with you, weighing 1115 g (2.5Êlb),

including batteries
• Expandable with PC Card accessories, USB devices, or

an external monitor
• Complete with a built-in modem (model 820 only)

HP Jornada makes mobile computing simple and easy.
Several valuable features allow you to stay organized and
in touch while you’re on the road. For instance:

• The HP Jornada viewer application displays Pocket
Outlook data at a glance, allowing you to navigate to or
view the data you need immediately. You can even view
notes attached to appointments.

• The HP Jornada dialup application allows fast and easy
access to your e-mail and the Web, letting you work as if
you were at your own desk.

• The HP Jornada backup application backs up informa-
tion to a CompactFlash Card or PC Card, safeguarding
against loss of data.

Your HP Jornada programs

Your HP Jornada already includes the full suite of software
that you need to function as a mobile professional.
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 The programs listed below are installed in ROM and cannot be erased or removed.

Microsoft Pocket Office

On the Start menu, point to Programs, point to Office,
and then click one of the following choices.

• Pocket Word—Take notes and compose documents, or
transfer Microsoft Word files from your desktop PC to
read and review while you’re away from your office.

• Pocket Excel—View and edit price lists or financial
forecasts on your HP Jornada, or fill out your expense
form before you even land at the home office.

• Pocket Access—Take database information with you on
the road, and fill in custom forms to update Microsoft
Access databases when you return to your office.

• Pocket PowerPoint—Create professional presentations
on your desktop, and then take them with you to show
on your HP Jornada, or project them with a direct
connection to an external monitor or VGA projector.

Microsoft Pocket Outlook

On the Start menu, point to Programs, point to Pocket
Outlook, and then click one of the following choices.

• Calendar—Never miss a meeting. Keep track of impor-
tant dates and events or manage your schedule.

• Contacts—Take your address book with you so that you
always have access to names, addresses, and telephone
numbers. If you update your HP Jornada contacts list,
just synchronize with your desktop PC and your contacts
will always be up to date.

• Inbox—Send and receive e-mail messages and synchro-
nize your HP Jornada Inbox with Microsoft Outlook or
Microsoft Exchange on your desktop PC partner in a
matter of minutes.
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• Tasks—Keep track of to-do lists. Set an alarm or a re-
minder and HP Jornada will make sure you never forget a
task!

Microsoft Pocket Internet Explorer

On the Start menu, point to Programs and then click
Internet Explorer. Or, double-click the Internet Explorer
desktop icon.

• Browse the Web from your HP Jornada or subscribe
to channel content with this streamlined version of
Microsoft Internet Explorer 4.0.1.

Communication

On the Start menu, point to Programs, point to Commu-
nication, and then click one of the following choices.

• ActiveSync™—Synchronize your HP Jornada with your
desktop or notebook PC over a network or dial-up
connection from a remote location.

• PC Link—Establish the connection between your
HPÊJornada and desktop PC partner in a single click.

• Remote Networking—Connect to a dial-up server,
RAS account, or Internet service provider.

• Terminal—Connect to online services that require
VT-100 or TTY terminal emulation.

• bFAX Pro—Send Word documents or typed notes
and receive faxes with bFAX Pro from bSquare.
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Special HP applications

On the Start menu, point to Programs, point to
HP Applications, and then click one of the following
choices.

• HP Jornada viewer—Display Calendar, Task, and
Contact information (Pocket Outlook) in as much detail
as you need so you are always in control of your sched-
ule. Month View, Week View, and Day View help you
manage your calendar even more efficiently. (Also
accessible through a desktop icon and through an HP hot
key.)

• HP Jornada dialup—Get connected quickly and easily.
Use this program to configure connections to the
Internet and e-mail accounts or corporate network, and
then dial in from a simple window on your desktop. (Also
accessible through a desktop icon.)

• HP Jornada backup—Protect your valuable data even
when you are away from your office by backing up your
Contacts, Calendar, and Tasks data or your entire device
to a CompactFlash or PC Card.

On the Start menu, point to Programs, point to HP
Utilities, and then click one of the following choices.

• HP Jornada settings—Adjust screen controls and sound
volume to suit any work environment. Also, view
memory information and set and activate password
protection.

• HP Jornada show—View the contents of your
HPÊJornada display on any VGA-compatible monitor or
projector so, you can give presentations or share your
work with others.

• HP Jornada touch pad—Scroll and point with this pad,
which offers the same navigation as a mouse, using only
your fingertip.
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Accessories

On the Start menu, point to Accessories, and then click
one of the following choices.

• InkWriter®—Use the InkWriter to jot quick notes or to
create sketches while in a meeting.

• Microsoft Voice Recorder—Record reminders or vital
information when there is no time to type.

• Calculator—Perform simple calculations in an on-screen
calculator, and then copy the results to any open docu-
ment.

• World Clock—Keep track of the time anywhere in the
world and display useful travel information for both your
home city and a city you are visiting.

• bFIND—Search for a word or text string in any data-
base, file, file name, or e-mail message stored on your
HPÊJornada.

• OmniSolve—Perform complex mathematical and busi-
ness calculations with this full-featured calculator from
LandWare.

Games

• Solitaire—Pass the time at the airport, on the train, or
during a not-so-interesting meeting or lecture with this
classic favorite.
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Maintaining your HP Jornada
With proper maintenance, your HP Jornada will be a
reliable desktop PC companion. Follow these tips to ensure
long and trouble-free use.

Cleaning the screen

Touching the HP Jornada screen with your hand will leave
a trace of natural oil that may make it difficult to read the
screen. To clean the screen, use a commercial glass cleaner
sprayed on a soft cloth. Avoid spraying the screen directly.

Dropping your HP Jornada

Dropping your HP Jornada can cause damage to delicate
components such as the display. Accidental damage is not
covered under the Hewlett-Packard express warranty.

Avoiding radiated interference

Radiated interference from other electronic equipment may
affect the appearance of the display and the modem func-
tion of the HP Jornada. Removing the HP Jornada from the
source of the interference will return the modem function
and display to normal.

Avoiding high temperatures

Your HP Jornada is designed to operate at temperatures
between 0 to 40ÊºC (32 to 104ÊºF) and to maintain data at
temperatures between 0 to 55ÊºC (32 to 131ÊºF). Subjecting
the device to temperatures higher than 55ÊºC (131ÊºF) may
damage the unit or result in loss of data. Be especially
careful not to leave your HP Jornada in direct sunlight or
in a car where temperatures can rise to harmful levels.
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This chapter will help you start using your
Hewlett-Packard Jornada 820 or 820e Handheld PC
(H/PC). You will learn how to set up your HP Jornada,
discover how to customize Microsoft® Windows® CE to
work for you, and you will have a brief introduction to the
Windows CE operating system. When you have finished
this chapter, you will have all the information you need to
begin working with your HP Jornada.

This chapterÊincludes step-by-step instructions to help you:

• Identify the hardware features of your HP Jornada

• Install the main and backup batteries

• Connect the AC adapter

• Run the Windows CE Welcome Wizard

• Put your HP Jornada to work for you

Chapter2.P65 0109 2/4/99, 4:03 PM13
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HP Jornada hardware features
The views below will introduce you to the various connec-
tors, ports, and other features of your HPÊJornada.

This is the back view of the HP Jornada.

• Infrared port (Fast IrDA–compliant transceiver)—
Enables you to send and receive files by infrared beam
between your HP Jornada and another HP Jornada
or palmtop PC, or between your HP Jornada and an
infrared-equipped printer or desktop PC.  (For more
information, see the Connecting by infrared section
in chapterÊ4.)

• External monitor port—Allows you to connect your
HPÊJornada to a full-size VGA–compatible monitor or
projector, so you can make business presentations any-
where, anytime. (For more information, see the Using
Microsoft Pocket PowerPoint and Using
HPÊJornada show sections in chapterÊ6.)

• Appointment notification LED—Notifies you of
scheduled appointments, alarms, and preset reminders
and allows you to turn off an alarm without opening your
HP Jornada. (For more information, see the Using
Microsoft Pocket Outlook section in chapter 5.)

• Universal Serial Bus (USB) host—Allows you to
connect a USB–compatible mouse, keyboard, or other
plug-and-play peripherals.  (For more information, see
the Adding peripherals section in chapterÊ7.)

Infrared port

External
monitor port

Appointment
notification LED

Telephone
connector (model
820 only)

USB (host) Security slot
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• Telephone connector (RJ-11)—Allows you to connect
a phone line to your HP Jornada modem, keeping you
in touch with the world. (For more information, see
the Connecting the phone line section in chap-
terÊ3.)

• Security slot—Allows you to keep your HP Jornada safe
with the connection of an optional Kensington security cable.

This is the right-side view of the HP Jornada.

• CompactFlash Type II Card slot—Enables you to
add memory or use accessories on CompactFlash Cards.
(For a list of recommended accessory cards, go to the
Hewlett-Packard Web site at www.hp.com/handheld.)

• CompactFlash release button—Ejects a
CompactFlash Card from the slot.

• AC port and AC power adapter—Connect your
HPÊJornada to AC power anywhere in the world to charge
the main battery or to connect to your desktop PC.

• Serial Port (RS-232C)—Connect your HP Jornada to
your desktop PC to transfer files, to synchronize Pocket
Outlook data, or to connect your HP Jornada directly to a
printer, external modem, or other device. (For more
information, see the Connecting for the first time
section in chapterÊ4.)

CompactFlash
Card slot

CompactFlash
release button

AC port

Serial port
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PC Card  slot

PC Card
release button

Backup battery
compartment

This is the left side view of the HP Jornada.

• PC Card Type II Card slot—Enables you to use PC
Cards (also called PCMCIA Cards) to expand memory or to
add functionality to your HP Jornada. (For a list of
recommended PC Cards, go to the Hewlett-Packard Web
site at www.hp.com/handheld.)

• PC Card release button—Ejects a PC Card from
the slot.

• Backup battery compartment—Holds two 3-V
CR2032 coin-cell backup batteries.
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Hot
keys

Reset button

On/Off
key

Audio
speaker

Battery
charging LED

This is the front view of the HP Jornada.

• Audio speaker—Plays system sounds or voice memos.

• Microphone—Allows you to record voice memos.

• Reset button—Quickly reinitializes the WindowsÊCE
operating system. (Warning: When you reset your
HPÊJornada, you will lose all unsaved data in any open
documents. See the Resetting section in chapterÊ8.)

• Keyboard—Allows comfortable touch typing and
includes embedded numeric keypad.

• Touch pad—Offers full customization for desktop
navigation. (See the Adjusting the HP Jornada
touch pad section in chapterÊ7.)

• Battery charging LED—Glows while the main
battery is charging (when connected to AC power).
Red indicates that the battery power is low, amber
indicates that the battery power is at 90 percent of
full power, and green indicates that the battery is
fully charged.

• HP Jornada hot keys—Allow one-touch access to your
favorite programs, folders, or documents. (See the Using
the HP Jornada hot keys section in chapterÊ7.)

Microphone

Touch pad
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Setting up your HP Jornada
Follow the steps below to start using your HP Jornada
for the first time. As part of the setup process, you will
install the batteries, turn on the device, and complete
the WindowsÊCE Welcome Wizard. To set up your
HPÊJornada, you will need your HP Jornada, the
HPÊJornada Standard Battery, the AC adapter and power
cable, and the backup batteries.

Follow the steps described below in the order they are presented. Do not install the
backup batteries before installing the main battery.

Installing the main battery

The HP Jornada Standard Battery provides power to your
HP Jornada when it is not connected to AC power. Under
normal operating conditions, the battery should provide
power for up to 10Êhours. Battery life will vary, however,
depending on how you use your HP Jornada.

The main battery fits into the bottom of your HPÊJornada,
as shown in the diagram.

This bottom view of the HP Jornada shows how to insert
the main battery.
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To install the main battery

1. Place your HP Jornada on a table or desk with the
bottom of the device facing up. Be sure the unit is
closed.

2. Place the main battery in the battery slot on the
bottom of your HP Jornada. The leads on the
battery should line up with the contacts on the
bottom of the device.

3. Slide the battery toward the back of your
HPÊJornada until it snaps into place.

After you install the main battery, your HP Jornada will turn on automatically.
However, you should connect the AC adapter and install the backup batteries before
using your device.

The main battery should be partially charged already when
removed from the box. However, you should charge the
main battery fully before operating your HP Jornada on
battery power. Charging the main battery takes approxi-
mately 3.5 to 5Êhours.

When you replace the main battery, your new battery must
be at least 30 percent charged before your HP Jornada will
turn on.

When your HP Jornada is operating on battery power, the
Power control panel displays the estimated time left on the
main battery. After you disconnect from the AC power, it
might take about 1 minute for the Estimated Time Left
indicator to be updated.

Connecting the AC adapter

To avoid running out of battery power, you can operate your
HP Jornada on AC power using the supplied AC adapter. The
AC adapter accepts voltages from 100 to 240ÊV, enabling
connections to AC power anywhere in the world. When you
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travel, you may need adapters to accommodate different
electrical outlets, but the HP Jornada AC adapter will
safely convert AC line voltage to the DC voltage required
by your HP Jornada.

When your HP Jornada is connected to AC power, the main
battery will be charged automatically. The LED on the
front of the battery indicates the status of the battery: the
red LED indicates that the battery power is low, and the
amber LED indicates that the battery is 90 percent
charged. When the battery is fully charged, the LED glows
green. The LED is illuminated only if your HP Jornada is
connected to AC power.

The AC adapter includes two parts:
the power cable and the adapter.

To connect to AC power

1. Connect the cable from the AC adapter to the AC
port on the right side of your HPÊJornada.

2. Connect the power cable to the AC adapter.

3. Plug the power cable into an AC power outlet.
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Use the AC adapter to plug your HP Jornada into external power whenever possible,
especially when connecting to a desktop PC, using a PC Card modem, NIC, or other
peripheral, or letting the LED indicator flash for extended time periods.

Installing the backup batteries

The two CR2032 coin-cell backup batteries protect your
data when the main battery runs out of power. The backup
batteries do not provide enough power to operate your
HPÊJornada, but they will preserve your data while you
replace the main battery or while you connect to AC power to
recharge.

To prevent loss of data, replace the backup batteries as soon as a warning message
appears on your screen indicating that backup battery power is low. See the Managing
battery power section in chapter 7.)

To install the backup batteries

1. Slide down the cover plate from the backup battery
compartment on the left side of your HP Jornada (see
diagram).

2. Remove the battery tray from the compartment by
pulling the ribbon attached to the cover plate.

3. Place the two backup batteries in the tray with the
positive side facing up.

Chapter2.P65 0109 2/4/99, 4:04 PM21



22 | HP Jornada H/PC User’s Guide

4. Carefully slide the tray into the backup battery
compartment.

5. Fold the ribbon inside the compartment and slide the
cover back on to the battery compartment.

Following the Welcome Wizard

After you install the main battery, your HP Jornada will
turn on automatically. At startup, the Hewlett-Packard
welcome screen appears. Then, after a few moments, the
Windows CE Welcome Wizard begins. The Welcome
Wizard presents a brief orientation that helps you to
configure device settings such as the World Clock and
Owner Identification.

Before you begin working, you may need to adjust the
brightness and contrast of the display to compensate for
different lighting conditions and viewing angles. You can use
the keyboard to adjust both contrast and brightness.

To adjust screen brightness and contrast

1. On the keyboard, hold down the  key as you press
 or  to increase or decrease the brightness.

2. Press  or  to adjust the contrast.
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The sections below describe the steps of the Welcome Wizard.
Follow the instructions displayed in the taskbar area at the
bottom of your screen to complete the Welcome Wizard.
When you have completed the Welcome Wizard, you will be
ready to begin using your HP Jornada.

To maximize battery life, minimize the brightness setting, and then adjust contrast to
achieve readability.

If your HP Jornada freezes during operation, you may need to perform a soft reset. To
reset, use a pen or paperclip to press the red reset button (located just above the On/Off
key). Your HP Jornada will restart automatically. Unsaved data in any open documents
will be lost. For more information, see the Resetting section in chapter 8.

Follow the instructions in the taskbar to complete the Welcome Wizard.
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Selecting your Home City

Windows CE bases its regional settings on the city you
designate as your “Home City.” Click the city nearest
your home in the drop-down list on the Home City
tab. If your city is not listed, you can use the World Clock
control panel to add it later. (See the World Clock topic in
online Help.)

Select the city nearest your home from this list.
World Clock displays regional information
based on the selected city.

Type the current time here to set the clock.
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Setting the World Clock

Windows CE uses the system clock to monitor your alarms
and appointments as well as to synchronize the most current
files and calendars with your desktop PC. So make sure you
set the correct time and date. Set the time by typing the
current time in the box below the clock face or by dragging
the hands on one of the clocks to the correct time. Set the
date by clicking the current date on the calendar (click the

 or  buttons to change day and month).

You can set the clock settings again later using the World
Clock control panel. (See the World Clock topic in online
Help.)

Adding owner information

You can set Windows CE to display owner information, such
as your name, address, and phone number. You can also type
a note to be displayed; for example, you can offer a reward for
the safe return of your HP Jornada.  To display your owner
information each time that you start your HP Jornada, select
the Display Owner Identification check box under
At Power On.

You can change the information you type here at any time by
using the Owner Properties control panel. (See the Settings
topic in online Help.)

Using your HP Jornada
After you complete the Welcome Wizard, you can begin using
your HP Jornada and its built-in programs.

Welcome to Microsoft Windows CE

Congratulations on purchasing a mobile device powered by
the Microsoft Windows CE operating system. The size and
capabilities of your HP Jornada let you keep your most
important business and personal information up to date and
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close at hand. Windows CE Services with ActiveSync™
increases the power of your HP Jornada by letting you
synchronize the information on your desktop or notebook PC
with your device.

Using the Start menu and Taskbar

Use the Start menu to open settings, Help, recently used
documents, and programs such as HP Applications. Just
click Start, and then click the program or item you want to
open. In addition to the Start menu, the taskbar contains
buttons for the programs you have running, a status area,
and a desktop icon.

Using the command bars

Each program has a command bar located at the top of the
program window. The command bar displays both menu
names and toolbar buttons. Click the slider and drag to
switch between displaying toolbar buttons only or menu
names and toolbar buttons. You can drag the slider to display
the buttons and menu names you want. You can also drag
the slider down to move the toolbar buttons under the
menus.

Click the Start menu, and then select the item you want.
Double-click an icon in the

status area for more
information.

Select the desktop icon to
minimize all open

programs and display the
device desktop.

Select to maximize (display) and
minimize (hide) a running program.
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Using Help on your HP Jornada

You can get Help for specific programs, including
WindowsÊCE, as follows:

• For detailed procedures and overview information about a
program, on the Start menu, click Help, and then click
the program name on the Contents tab.

• For Windows CE Help, click the  button in any pro-
gram or dialog box where it appears.

• To learn the function of a specific button or control, click
and hold on a toolbar button and its name will appear in a
ToolTip. Drag off the toolbar button before lifting to avoid
activating the button.

Turning HP Jornada on and off

One of the most convenient features of Windows CE and
HPÊJornada is “instant on.” With instant on, there is no
waiting for HP Jornada to start up or shut down; you can
start working immediately by pressing the On/Off key on the
upper right corner of the keyboard. When you are finished,
turn off your HP Jornada by pressing the On/Off key or by
clicking Suspend on the Start menu. Turning off your
HPÊJornada simply suspends operation. When you turn it on
again, you can start working where you left off.

To conserve battery power, you can set HP Jornada to
auto-suspend or to turn itself off after a preset period of
continuous idle time. By default, your HP Jornada will auto-
suspend after 3 minutes while running on battery power.
(For more information on auto-suspend and tips for conserv-
ing battery power, see the Managing battery power
section in chapterÊ7.)
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Using the HP Jornada keyboard

To provide full functionality in a smaller size, the
HPÊJornada keyboard lets you accomplish common
tasks with a few convenient key combinations:

• To turn the caps lock on or off, press and hold the
Fn/AltGr key as you press the left  key. While the
caps lock is on, the  symbol appears in the status area of
the taskbar.

• To activate (or deactivate) the numeric keypad, press and
hold the Fn/AltGr key as you press the  key. While the
numeric keypad is activated, the  symbol appears in the
status area of the taskbar.

• To type accented or international characters, press and
hold the Fn/AltGr key as you press the key combination
corresponding to the character (international versions
only). International versions of the HP Jornada have
slightly different keyboard layouts.

You can also use the Keyboard control panel to adjust the how quickly characters repeat
when you hold down a key. To open the Keyboard control panel, press .

Using the HP Jornada settings control panel

The HP Jornada settings control panel gives you access to
many useful controls. Use the HP Jornada settings control
panel to:

• Adjust your screen brightness and contrast in different
lighting conditions

• Adjust speaker volume or quickly mute all sounds

• Check the remaining battery power

• Check the amount of system memory available
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HP Jornada settings also enable you to save your preferred
settings in a custom profile so that you can change all your
options with a single click.

To open the HP settings control panel

1. On the Start menu, point to Programs, point to
HP Utilities, and then click HP settings.
–or–
Press the HP Jornada settings hot key .

For more information about the HP Jornada settings applica-
tion, see the Using the HP settings application section in
chapter 7 or the HPÊJornada settings topic in online Help.
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Accessing e-mail     | 3

With your HPÊJornada Handheld PC (H/PC), you can keep
in touch with your office, home, and clients through e-mail
and the Internet. You can connect in myriad ways using
your HPÊJornada and various accessories. This chapter will
guide you through the options best suited to your needs.

This chapterÊprovides information that allows you to:

• Decide why and how you want to connect
• Set up your HPÊJornada to access personal e-mail and

the Internet
• Set up your HPÊJornada to access corporate e-mail and

your network or PC when you are away from the office
(offsite)

• Set up your HPÊJornada to access corporate e-mail and
network resources when you are in the office (onsite)

• Set up additional connections with the HP Jornada dialup
application or Remote Networking

• Use your connections with Inbox and Microsoft® Pocket
Internet Explorer

and the Web
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Deciding how and why you want to connect
The method you use for sending and receiving your
e-mail, browsing the Internet, and accessing other remote
resources depends on your goals and situation. Do you:

• Need access to personal (non-corporate) e-mail
and the Internet?

• Need access to corporate e-mail and network services
when you are on the road or out of the office?

• Need access to corporate e-mail and network services
when you are onsite at your company?

• Want access to your CompuServe™ mail?

Your answers to these questions will help you determine
which equipment you can use in combination with your
HPÊJornada to keep in touch online. The following illustra-
tion depicts the different solutions to your online needs.

Which connection options are right for you?
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Accessing personal e-mail and the Internet

If you want e-mail and Internet service only (with no
access to a company network), you will need:

• An installed modem—If you have the HPÊJornada 820,
you have an internal modem so you are ready to go. If you
have the HPÊJornada 820e, you can choose from a variety
of available PC Card modems. (For more information
about compatible PC Card modems, go to the HPÊJornada
Accessories page on the Hewlett-Packard Web site at
www.hp.com/handheld.)

• A PPP (Point-to-Point Protocol) or SLIP (Serial
Line Internet Protocol) account—An Internet service
provider (ISP) will provide you with important informa-
tion, such as a user name, password, dial-up phone
number, server names, and so on.

• A dial-up connection set up on your HP Jornada—
This step is made easier with the HP Jornada dialup
application.

• Access to a phone line—You can connect to an analog
phone line with your HP Jornada 820. Or, connect to the
type of phone line supported by the PC Card modem you
install in the HPÊJornada 820e.

If you use the HP Jornada 820, you must use an analog phone line to connect your
modem; connecting to a digital phone line can damage your modem.
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Installing and configuring a modem

The HP Jornada 820 has a built-in 56K V.90 modem for
easy communication, so no installation is required. The
HPÊJornada 820e supports a variety of available PC Card
modems. (For more information about compatible PC Card
modems, go to the HP Jornada Accessories page on the
Hewlett-Packard Web site at www.hp.com/handheld.) Follow
the manufacturer’s instructions included with the PC Card
modem to install and configure it for use with your
HPÊJornada.

Getting an account with an Internet service provider

To access the Internet and e-mail, you will need to contact
an ISP to set up a PPP account. SLIP accounts are offered
by some ISPs instead of PPP accounts. Your HP Jornada
supports the use of SLIP as well as PPP.

Your ISP will be able to give you all the configuration infor-
mation you need to connect your HP Jornada to the Internet
and e-mail service. Please be sure to note the following:

• Your account user name.
• Your account password.
• Phone number of your ISP’s modem.
• IP and DNS addresses, if necessary.
• Your e-mail user name or ID. (This may be the same as

the user name for your ISP account.)
• Your e-mail password. (This may be the same as the

password for your ISP account.)
• The POP3 or IMAP4 host name of your ISP.
• The SMTP host name of your ISP (if required by your ISP).
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Setting up a dial-up connection to your ISP

After you have established an account with an ISP, you can
set up a connection on your HPÊJornada and connect to the
Internet and your e-mail whenever you want. To make this
configuration process easier, use the HPÊJornada dialup
application. The HP Jornada dialup application leads you
through the process of configuring your connections, including:

• Setting up a connection to your ISP
• Setting up an e-mail service (if you choose E-mail Service

as an option)
• Setting up a Web service (if you choose Web Service

as an option)
• Setting up a location, a procedure that sets dialing options

The following sections describe the process that the
HPÊJornada dialup application will lead you through
and the type of information you will need to provide.

ISP connection

This portion of the program allows you to save and name
your ISP connection configuration. You can have more than
one connection configuration (for example, one connection to
your corporate network and one to your personal ISP), so
choose a connection name that will make it easy to deter-
mine which connection you want when you are ready to dial
up. At this point, you will also complete the following tasks:

Choose E-mail or Web Service—You can choose one or
both options. Most ISPs offer both e-mail and Web services.

Choose Typical or Advanced setup—Typical setup will
automate most of the connection configuration by using
default settings. Advanced setup allows you more control
over setup options. Typical and Advanced setup options are
offered at the beginning of each stage of the HPÊJornada
dialup configuration process: ISP service setup, E-mail
Service setup, and Web Service setup.
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Input ISP information—This includes the information
you collected from your ISP, such as the dial-up telephone
number and IP, DNS, and WINS address settings. Many
ISPs automatically (or, dynamically) assign both IP and
DNS addresses. If your ISP does not assign these automati-
cally, you should clear the Server-assigned addresses
option and type the addresses.

When you enter the IP address, you can also choose to use
SLIP if your ISP uses this protocol. PPP is the HP Jornada
default protocol for this option, but SLIP is supported as well.

You also have the option to choose software and IP header compression options. Ask your
ISP if these options are recommended for your account.

E-mail Service

At this stage in the HP Jornada dialup process, you can
input the following e-mail information:

UserID and password—The user name (UserID) and
password you use to access your e-mail account may be the
same as the user name and password you use to connect to
your ISP. However, some ISPs assign a different name and
password for this service.

Service types—Your ISP may use POP3 or IMAP4 for
receiving mail. In addition to using IMAP4 or POP3, some
ISPs use SMTP (Simple Mail Transfer Protocol) for sending
messages. This is an optional setting; refer to your ISP to
find out if this applies to your configuration.

Settings—You can choose a variety of E-mail Service
settings. If you are using POP3, you can ensure that your
sent e-mail complies with MIME formatting (Multipurpose
Internet Mail Extensions, a format that allows binary mes-
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sages, such as graphics and audio files, to be sent over the
Internet). You can also set e-mail services to:

• Disconnect after actions are performed
• Check for new mail at specified intervals
• Display a message or sound an alarm when new

mail arrives
• Only display messages from a specified number

of recent days
• Get message headers only whenever you connect (for full

download later)
• Get full copies of all messages and decide whether to

download attachments when you connect.

The default options represent the settings used by many ISPs. If you are not sure, or you
do not have guidance from your ISP, try the default settings.

Fill in your E-mail Service information.
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Web service information

The HPÊJornada dialup application prompts you to select
settings for Web services, such as your Home and Search
pages, AutoDial and AutoDisconnect, plus Advanced options.
Advanced options include security settings, caching (and
cache size), and enabling cookies. You can also set a proxy
server address, although this is not generally  necessary for
ISP connections.

Home and Search pages—Set addresses for your Home
and Search pages using this option.

AutoDial and AutoDisconnect—These options allow
HPÊJornada to connect and disconnect automatically from
your ISP when an application (such as the Inbox program or
Pocket Internet Explorer) requires access. Remember that
your device needs to be connected to the phone line before a
connection is possible.

Pocket Internet Explorer appearance—Select the
appropriate check box to show pictures, play sounds, or
make the Web page fit onto your device screen. Making
these adjustments can decrease or increase your Web
browsing speed in some cases.

Advanced settings—Control some advanced Web service
features with the HP Jornada dialup application. You can
enable cookies and caching and set security levels with
this option.

Advanced security settings include the option to select from
two versions of SSL (Secure Socket Layer) or PCT (Private
Communication Technology). These protocols maintain the
security and integrity of the transmission channel by
using encryption, authentication, and message-authenti-
cation codes.
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Location     information

Your location settings set your dialing options with respect
to your dialing location. You will be able to save and name
this group of settings as a profile so that you can choose
among profiles when you dial up. For instance, you can
create one connection profile for dialing from a hotel and
another profile for dialing from your home.

After you collect the necessary information, you are ready to
start the HPÊJornada dialup application.

To create your connection profile

1. Double-click the HP dialup icon on your HP Jornada
desktop. The first dialog box appears.

2. Fill in the information requested in each screen.

3. When you are finished, click Done.

After you have completed this configuration process, you will
be able to select the connection profile from the HPÊdialup
window on your desktop.

If you have already created one connection profile using the HP Jornada dialup
application, you can add another by clicking Edit next to the Connection box
in the HP dialup window. Then, click Create New Connection.

Connecting the phone line

After you have configured your connection to your ISP, you
are ready to connect your phone line to your modem or
device and then dial in. To connect to the phone line sup-
ported by your modem, follow the instructions provided by
the manufacturer. To connect to an analog phone line, use
the following procedure.
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To connect an analog phone line to your HP Jornada

1. Connect the phone cord to the phone jack.

2. Connect the other end of the phone cord
to the phone connector on the back of your
HP Jornada or to your PC Card modem (following
the instructions provided by your modem manufac-
turer).

If you are unable to find an analog phone line, use the line dedicated to a fax machine.
Fax machines use only analog lines.

Dialing in

When you are ready to dial in to your ISP, use the HPÊdialup
window.

To connect to your ISP

1. Double-click the HP dialup icon on your desktop.
The HP dialup window appears.

2. Select a location and a connection from the
drop-down boxes, and then click Continue.

3. In the Dial dialog box, confirm the user name and
password you use to connect to your ISP, and select
the modem you will use to dial the call.
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4. Check the phone number, supply the prefix if neces-
sary, and then click Dial. A progress message
appears to tell you when you are connected to your
network, and then an icon appears in the taskbar
while you remain connected.

5. To disconnect, double-click the connection icon
in the status area of the taskbar, and then click
Disconnect.

After you are connected to your ISP, use the Inbox program
to send and receive e-mail or use Pocket Internet Explorer to
browse the Web. (For more information, see the Sending,
receiving, and processing your e-mail and Browsing
the Web or your intranet with Pocket Internet
Explorer sections in this chapter.)

Connecting to corporate e-mail and network
from offsite

If you want access to corporate e-mail and Internet services
when you are offsite, you will need:

• An installed modem—If you have the HP Jornada 820,
you have an internal modem, and you are ready to go. If
you have the HP Jornada 820e, you can choose from a
variety of available PC Card modems. (For more informa-
tion about compatible PC Card modems, go to the
HPÊJornada Accessories page on the Hewlett-Packard
Web site at www.hp.com/handheld.)

HP
connection

icon
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• An account with your corporate network set for
dialing in to your network server—Your network
administrator can provide you with important informa-
tion, such as a user name, password, dial-up phone
number(s), server names, and so on.

• A dial-up connection set up on your HP Jornada—
This step is made easier with the HP Jornada dialup
application, included on your HP Jornada.

• Access to a phone line—You can connect to an analog
phone line with your HP Jornada 820. Or, connect to the
phone line supported by your PC Card modem if you have
the HP Jornada 820e.

If you use the HP Jornada 820 (with built-in modem), you must use an analog phone
line to connect your modem. Connecting to a digital phone line can damage your modem.

Installing and configuring a modem

The HP Jornada 820 has a built-in 56K V.90 modem for
easy communication, so no installation is required. The
HPÊJornada 820e supports a variety of available PC Card
modems. (For more information about compatible PC Card
modems, go to the HP Jornada Accessories page on the
Hewlett-Packard Web site at www.hp.com/handheld.)  To
install and configure a PC Card modem for use with your
HP Jornada, follow the manufacturer’s instructions .

Establishing a network dial-up account

Before you can log on to your network using a modem, you
must establish a network account with your network admin-
istrator. Most likely, you will dial in to a server that has a
modem installed to receive your call. The information you
need for this connection is similar to the information needed
to connect to the Internet through an ISP:

• Your account user name
• Your account password
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• Phone number of network server modem
• IP, DNS, and WINS addresses, if necessary
• Your e-mail user name or ID (This may be the same as

your user name.)
• Your e-mail password (This may be the same as your

user password.)
• The network POP3 or IMAP4 host name
• The network SMTP host name (if required)

Setting up a remote connection to your network

When you are connecting to your network, you can use the
HP Jornada dialup application to create a connection for you.
Once you have set up an account with your network adminis-
trator, you need to set up a connection on your HPÊJornada
so that you can connect to your network, e-mail, and intranet
(possibly including the Internet) whenever you want to. The
HP Jornada application leads you through the process of
configuring for your connections, including:

• Setting up a connection to your network.
• Setting up an e-mail service (if you choose E-mail Service

as an option).
• Setting up a Web service (if you choose Web Service as

an option). In this case, the Web may be your corporate
intranet or the Web.

• Setting up a location, which sets dialing options.

You will have the opportunity to set the following options
during the configuration process.

Service provider connection

This portion of the program allows you to name and save
your network connection configuration. You can have more
than one connection created (for instance, if you want to
connect to your corporate network resources as well as a
personal ISP). So, naming the connections will help you
know which connection you want to choose when you are
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ready to dial up. At this time, you will also complete the
following tasks:

Choose E-mail or Web Service—You can choose one or
both options. Your network administrator can tell you which
options are available to you.

Choose Typical or Advanced setup—Typical setup will
automate most of the connection configuration by using
default settings. Advanced setup allows you more control
over setup options. Typical and Advanced setup options are
offered at the beginning of each stage of the setup process:
Service Provider (in this case, your network administrator),
E-mail Service, and Web Service.

Input Service Provider information—This includes
information provided by your network administrator, such
as the dial-up telephone number and IP, DNS, and WINS
address settings. Many networks automatically (or, dynami-
cally) set both IP and DNS addresses. If your network does
not assign these automatically, you should clear the Server-
assigned addresses option and type the addresses.

When you set the IP address, you can also choose to
use SLIP (Serial Line Internet Protocol) if your network
uses this protocol. PPP (Point-to-Point Protocol) is the
HPÊJornada setup default protocol, but SLIP is supported as
well. If you have a SLIP account, select the Use SLIP check
box during the IP setup portion of the HP Jornada dialup
configuration process.

You also have the option to choose software and IP header compression options. Ask your
network administrator if these options are recommended for your account.
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E-mail Service

At this stage in the process, you can input the following
e-mail information:

UserID and password—The user name (UserID) and
password you use to access your e-mail account may be the
same as the user name and password you use to log on to
your network. However, sometimes another name and
password are used for this service.

Service types—Your network may use POP3 or IMAP4
protocol for receiving mail. Networks use another protocol
for sending messages, called SMTP (Simple Mail Transfer
Protocol). Some networks may require you to enter SMTP
server information. Refer to your network administrator to
find out if this requirement applies to your configuration.

Settings—You can choose a variety of E-mail Service
settings. You can ensure that your sent e-mail complies with
MIME formatting (Multipurpose Internet Mail
Extensions, a format that allows binary messages, such as
graphics and audio files, to be sent over the Internet). You
can also set e-mail services to:

• Disconnect after actions are performed
• Check for new mail at specified intervals
• Display a message or sound an alarm when new mail

arrives
• Only display messages from a specified number of

recent days
• Get message headers only when you connect (for full

download later)
• Get full copies of all messages and decide whether to

download attachments when you connect

The default options offer the settings used by many service providers. If you are not sure
which settings to use, or you do not have guidance from your network administrator, try
the default settings.
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Fill in your E-mail Service information.

Web service information

This portion of the HP Jornada dialup application configures
Web service information, such as your Home and Search
pages, AutoDial and Auto Disconnect, plus Advanced op-
tions. Advanced options include enabling cookies, caching
(and cache size), and security settings. You can also set a
proxy server address.  Check with your network administra-
tor to see if this applies to your settings.

Home and Search pages—Set addresses for your Home
and Search pages using this option.

AutoDial and AutoDisconnect—These options allow
HPÊJornada to connect and disconnect automatically from
your ISP when an application (such as the Inbox program or
Pocket Internet Explorer) requires access. Remember that
your device needs to be connected to the phone line before a
connection is possible.

Pocket Internet Explorer appearance—Select the
appropriate check box to show pictures, play sounds, or
make the Web page fit in your device screen. Making these
adjustments can decrease or increase your Web browsing
speed in some cases.
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Advanced settings—Control some advanced Web service
features with the HP Jornada dialup application. You can
enable cookies and caching and set security levels with
this option.

Advanced security settings include the option to select from
two versions of SSL (Secure Socket Layer) or PCT (Private
Communication Technology). These protocols maintain the
security and integrity of the transmission channel by using
encryption, authentication, and message-authentication codes.

Location information

Your location settings set your dialing options with respect
to your dialing location. These settings include the city and
state/province you are dialing from, country code, area code,
plus other dialing options. You will also be able to save and
name this group of settings as a profile so that you can
choose among more than one profile when you dial up. For
instance, you can create one connection profile for dialing
from a hotel and another profile for dialing from your home.

After you collect the necessary information, you are ready to
start the HP Jornada dialup application.

To create your connection profile

1. Double-click the HP dialup icon on your
HPÊJornada desktop.

2. Fill in the information requested in each screen.

3. When you are finished, click Done.

After you complete this configuration process, you can click the
connection profile in the HP dialup window on your desktop.

If you have already created one connection profile using the HP Jornada dialup
application, you can add another by clicking Edit next to the Connection box in the
HP dialup window. Then, click Create New Connection.
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Connecting the phone line

After you have configured a connection to your network, you
are ready to connect the phone line to your modem or HP
Jornada and then to dial in. To connect to types of phone
lines supported by your modem, follow the instructions
provided by your modem manufacturer. To connect to an
analog phone line, use this procedure.

To connect the phone line to your HP Jornada

1. Connect the phone cord to the phone jack.

2. Connect the other end of the phone cord to
the phone connector on the back of your
HPÊJornada or to your PC Card modem
(following the instructions provided by your
modem manufacturer).

Dialing in

Use the HP Jornada dialup application to dial in to
your network.

To connect to your network

1. Double-click the HP dialup icon on your desktop. The
HP dialup window appears.
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2. Select a location and a connection from the drop-
down boxes, and then click Continue.

3. In the Dial window, confirm the user name and
password you use to log on to your network, and
select the modem you will use to dial the call.

4. Check the phone number, and then click Dial. A
progress message appears to tell you when you are
connected to your network, and then an icon appears
in the taskbar while you remain connected.

5. To disconnect, double-click the connection icon
in the status area of the taskbar, and then click
Disconnect.

After you are connected to your network, you may use the
Inbox program to send and receive e-mail or use Pocket
Internet Explorer to browse your corporate intranet or the
Web. For more information, refer to the Sending, receiv-
ing, and processing your e-mail and Browsing the
Web or your intranet with Pocket Internet Explorer
sections in this chapter.

Connecting to corporate e-mail and
network resources onsite

If you want corporate e-mail and Internet service only (with
no access offsite), you will need:

• An installed network interface card (NIC)—You will
need an NIC that is properly configured with the IP
address of your DNS and WINS servers (your network
administrator can give you this information).

HP
connection

icon
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• An account with your corporate network—Your
network administrator will give you important informa-
tion, including an IP address for your HP Jornada, if it is
not dynamically assigned

• A network (LAN) connection—This includes the
physical connection to your LAN.

Installing the network interface card

Before you can connect directly to a network, you must
install an NIC and properly configure it with the IP address
of your DNS and WINS servers (check with your network
administrator for this information).

You must use an NIC to connect your HP Jornada di-
rectly to a LAN. NICs are available from several manu-
facturers as PC Card accessories. (For a list of recom-
mended PCÊCard NICs, go to the Hewlett-Packard Web
site at www.hp.com/handheld.) Install the PC Card NIC in
the PCÊCard slot on your HP Jornada, and then attach the
network cable according to the instructions provided by
your card manufacturer.

In addition to the PC Card NIC, you will need to install the
appropriate driver software to configure the NIC. Drivers for
Proxim 7400 and Socket LP-E LAN cards are included on
the HP Jornada. Drivers for other cards must be obtained
from the card manufacturer. Install software drivers as you
would any other third-party program. (For more informa-
tion, see the Installing programs section in chapterÊ7.)
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Establishing an account or guest privileges
on the network

Contact your network administrator to set up an account or
guest privileges on the network. The network administrator
will give you the information you need to log on to the
network just as you do with your desktop PC, including user
name, password, domain name, and IP address
(if applicable).

Use the Network control panel to configure the NIC using
the information your network administrator has provided
to you.

To configure the NIC

1. On the Start menu, point to Settings, and then
click Control Panel.

2. Double-click the Network icon. The Network
Configuration dialog box appears.

3. On the Adapters tab, select the driver or adapter,
and then click Properties. Check with your net-
work administrator if do not know which settings to
use.

4. On the Identification tab, enter your user name,
password, and domain name. This information will
be saved, so you will not have to type it every time
you connect to a network resource.

Connecting the network cable and logging on

The final step before you can log on to the network is to
connect your NIC to the network cable. Follow the
manufacturer’s instructions included with your PC Card and
contact your network administrator for further assistance.
Now, you can log on just as you do from your desktop PC.
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To log on to the network with your HP Jornada

1. Plug the NIC into the PC Card slot on your
HPÊJornada. The network will establish a
connection automatically.

After you have connected your HP Jornada to the network,
you can access a file on a network file server by typing the
complete path to the file in the Windows CE address bar.

To access a file on a network

1. On the Start menu, point to Programs, and then
click Windows Explorer.

2. Be sure the address bar is visible—on the View
menu, be sure a check mark appears next to
Address Bar.

3. In the address bar, type the full network path
to the file you want to open, using the format
file:///servername/share/filename.

Or, click here to see a list of recently accessed files.

Type the full network
path in the address bar.

Chapter3.P65 0109 2/4/99, 4:12 PM52



Chapter 3 | Accessing e-mail and the Web     | 53

Windows Explorer keeps a list of the most recently used Internet and network resources, so
you do not have to type the path each time. Select a network path or URL from the drop-
down list.

Creating and modifying connections
You may set up more than one connection using the
HPÊJornada dialup application; for example, you may create
separate connections for access to your personal e-mail and
for network access. After you have set up the first e-mail/
Internet or network connection, use the HPÊJornada dialup
application to create another connection. You can also use
the  HP Jornada dialup application to modify existing
connections; for instance, you may want to change the
dial-up phone number or the dialing location.

To create an additional connection or location

1. Double-click the HP dialup icon on your desktop.
The HP dialup window appears.

2. Click Edit next to the Connection or
Location box.

3. In the Connections or Locations dialog box, click
Create New Connection or Create New Loca-
tion. The dialog boxes will appear just as they did
when you created the first connection.

4. Fill in the necessary information, according to the
type of connection or location you wish to make.
(Refer to sections earlier in the chapter.)

5. When you are finished, click Done. Your new
connection or location will appear in the HP dialup
window.
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Use HP dialup to modify connections you have set up with HP dialup, and use Remote
Networking to modify connections you have set up with Remote Networking. If you change
an HP dialup connection using Remote Networking, the registry is saved incorrectly, and
the connection can no longer be used.

To modify an existing connection or location

1. Double-click the HP dialup icon on your desktop.

2. Select the location or connection that you want to
modify from the drop-down lists.

3. Click Edit.

4. In the Connection or Location dialog box, click
Modify.

5. Make the modifications you want, and then click
Done to save your changes.

Creating connections without the HP Jornada
dialup application
You can also create connections to your Internet service
provider (ISP) or network by configuring the necessary pro-
grams manually. Before you can dial up, you will need:

• An installed modem—If you have the HPÊJornada 820,
you have an internal modem so you are ready to go. If you
have the HPÊJornada 820e, you can choose from a variety
of available PC Card modems. (For more information
about compatible PC Card modems, go to the
HPÊJornada Accessories page on the Hewlett-Packard
Web site at www.hp.com/handheld.)
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• A PPP, SLIP, or corporate account—Set up an
account with an ISP or your corporate network adminis-
trator (for remote access to your corporate network).
Gather the same service provider information that is
described in the previous sections in this chapter.

• A Remote Networking connection—You will need to
set up a Remote Networking connection as described in
this section.

• Dialing patterns and dialing locations—You will
need to set these options manually in Remote Networking.

• Inbox program and Web services—For more infor-
mation, see sections on the Using Inbox and Brows-
ing the Web or your intranet with Pocket Internet
Explorer sections later in this chapter.

• Access to a phone line—You can connect to an analog
phone line with your HP Jornada 820. Or, connect to the
type of phone line supported by the PC Card modem you
installed in the HP Jornada 820e.

To set up a Remote Networking connection

1. If your HP Jornada does not have a built-in modem,
install a PC Card modem.

2. Get the following information from your service
provider (ISP or network administrator): dial-up
access telephone number, user name, password, and
domain name.

3. On the Start menu, point to Programs, point
to Communication, and then click Remote
Networking.

4. Double-click the Make New Connection icon. The
Make New Connection dialog box appears.

5. Enter a name for the connection, such as “Corporate
Dial-Up,” click Dial-Up Connection, and then
click Next.
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6. Select your modem type from the list. You should
not need to change settings in the Configure or
TCP/IP Settings dialog boxes. When you are
finished, click Next.

7. Enter the access phone number and click Finish.

Once you have created the dial-up connection, simply
double-click the connection, enter your user name, pass-
word, and domain, and click Connect any time you want
to connect.

Once connected, you can use Pocket Internet Explorer to
visit Web pages and the Inbox program to send and receive
e-mail. Before you can use the Inbox program, you need to
provide the information it needs to communicate with the
mail server. See the Using Inbox section later in this
chapter.

To set a dialing location for a Remote Networking connection, double-click the icon for the
connection in the Remote Networking folder. In the Dial-up Connection dialog box,
click Dial Properties, and then fill in the information as you would for a network or
ISP connection using the HP Jornada dialup application.

Using your connections
Now that you have set up for the connection that best meets
your needs, you are ready to use that connection for e-mailing
or browsing the Web, or receiving your CompuServe mail.

Using Inbox

You can use the Inbox program to send and receive e-mail
over the Internet with your HP Jornada. You can also
exchange e-mail over your company’s intranet, either by
remote dial-up (using your modem) or by direct connection
(with an NIC). Using Windows CE Services, you can
synchronize information in Microsoft Outlook, Microsoft
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Schedule+, or Microsoft Exchange on your desktop
computer with your HP Jornada. Each time you syn-
chronize, WindowsÊCE Services compares the changes
you made on your HPÊJornada and desktop PC and
updates both computers, including changes to the mes-
sages in your Inbox. For more information, see chapter 4,
Connecting to your desktop PC.

The HP Jornada dialup application automatically sets up an Inbox service for you.
However, you can also set up Inbox services from within the Inbox program.

To set up e-mail service (Internet Mail)

1. Get the following information from your ISP or
network administrator: POP3 or IMAP4 server
name, SMTP host name, user name, password, and
domain name (for network connections only).

2. On the Start menu, point to Programs, and then
point to Pocket Outlook. Click Inbox.

3. In Inbox, on the Services menu, click Options.

4. On the Services tab, click Add.

5. Choose IMAP4 Mail or POP3 Mail, enter a name
for the connection, and then click OK.

6. In the Mail Service Definition dialog box, enter
the information from step 1. In Connection, choose
the remote connection you want to use. (If you are
receiving e-mail through a network connection, click
Network Connection.)

If you have not created a connection, click Create new connection, double-click the
Make New Connection icon, and follow the instructions in the wizard. When finished, click
Inbox on the Taskbar and continue setting up the Inbox.
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7. In the Mail General Preferences dialog box,
select the desired options.

8. In the Mail Inbox Preferences dialog box, select
the desired options.

9. In When Getting Messages, choose how you
want messages downloaded by default. Choosing Get
full copy of messages will take up more storage
space on your HP Jornada. Choosing Only synchro-
nize Inbox folder hierarchy (IMAP4 only) will
speed up the time it takes to download your mes-
sages.

10. In When Getting Full Copy, choose whether you
want to download file attachments and meeting
requests when you get full copies of messages. This
setting applies whether you have chosen to download
full copies of messages by default or to selectively
download full copies of messages by opening the
message and clicking the Get Full Copy button. In
addition, if you want to receive meeting requests,
your Exchange Server administrator must enable
support for Rich Text Format for your account.

For more information about Inbox settings, see the Inbox
settings section later in this chapter.

Sending, receiving, and processing your e-mail

You can send and receive e-mail over the Internet with
Inbox. All you have to do is configure a connection to your
ISP or corporate network (with HP Jornada dialup applica-
tion or Remote Networking) and set up an e-mail service
(either with the HP Jornada dialup application or within the
Inbox program itself). You can connect to your ISP or
network from within Inbox.
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To connect to your service provider from Inbox

1. On the Services menu, click the connection you
would like to dial.

2. Click Connect.

3. Type in your user name, password, and domain
name, if necessary.

4. Click Dial Properties if you need to modify or
choose a different location.

5. Click Connect. A message will appear to show you
the status of your connection. When your connection
is established, you can send and receive mail.

You can connect to your e-mail account and download messages to your HP Jornada even
if your desktop PC (partner) e-mail service is not Outlook or Exchange (for instance, if your
e-mail service is Lotus Notes). However, you can only synchronize with your desktop PC
mail if your desktop PC uses Outlook or Exchange mail client.

Inbox settings

When you connect to the mail server, the messages on your
device and mail server are synchronized: new messages are
downloaded to the HPÊJornada Inbox folder, messages in the
HP Jornada Outbox folder are sent, and messages that have
been deleted on the server are removed from your Inbox. If
you read a message and decide that you need the full copy,
click the Get Full Copy button on the Inbox toolbar.

You can set Inbox to download all your messages or
only new message headers to the Inbox folder. Downloading
only the message headers saves space on your HPÊJornada.
The original messages remain on the mail server. Then, you
can select messages that you want to read and download
those messages the next time you connect. Icons on the
Inbox message list indicate message status. You can specify
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a line limit for messages that you download. To set these
and other preferences, on the Services menu, click
Options, select the service you want to modify, and then
click Properties.

Attachments

When you send an attached file, such as a Pocket Word file,
be sure the recipient can read the file type you are sending.
Pocket Word files (.pwd) can only be read by other
WindowsÊCE devices such as the HPÊJornada. You can
choose to save the file as .txt or .rtf if you are unsure, or you
can choose to save the file as a Word file (.doc). For more
information about reading and sending e-mail attachments,
see online Help.

If you choose to download attachments to messages, you
can read them or save them on your HP Jornada or storage
device. You can save attachments automatically to a storage
card.

To save attachments automatically to a storage card

1. On Services menu, click Options.

2. On the Storage tab, select the Extended Storage
Card radio button. Click OK.

Message deletion

When you delete messages from your HP Jornada while you
are still connected to your service provider, the messages
will be deleted from the server as well. If you delete the
message after you disconnect, the message will be deleted
from the server the next time you connect. See online Help
for more information.
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Synchronization with your desktop PC

You can synchronize your HP Jornada e-mail with the e-
mail program (Outlook or Exchange) on your desktop PC
partner. When you synchronize:

• Messages are copied from the Inbox folder on your
desktop computer to the Inbox folder on your HP
Jornada (by default, no attachments will be copied).

• Messages on the two computers are linked. So, for
instance, if you delete a message on your HP Jornada,
it will also be deleted on your desktop PC the next time
you synchronize.

• Messages in the Outbox folder on your HP Jornada are
transferred to the Outbox on your desktop PC and then
sent from that program.

If you want to synchronize your e-mail, you must connect to
your desktop PC partner. In the Mobile Devices window,
choose ActiveSync Options from the Tools menu, and
then click Message. For more information about synchro-
nizing, see the Connecting to your desktop PC section
in chapterÊ4.

Browsing the Web or your intranet with
Pocket Internet Explorer

You can use Pocket Internet Explorer to browse the Web or
your corporate intranet with your HP Jornada. Pocket
Internet Explorer allows you to view Web sites in their
entirety directly on your HP Jornada. After you have set up
an online connection with your ISP or your network ac-
count, you are ready to dial up and start browsing the Web
or your intranet. You can set Pocket Internet Explorer to
automatically dial a connection you create whenever you use
Pocket Internet Explorer.
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If you did not use the HP Jornada dialup application to create your ISP or network
connection, you must set up a Remote Networking account first. (See the Creating
connections without the HP Jornada dialup application     section in this
chapter.) Then, set up Options in Pocket Internet Explorer.

The HPÊJornada dialup application automatically updates
the Pocket Internet Explorer settings. However, any
changes you make within Pocket Internet Explorer will
not be reflected in the HP Jornada dialup box that you use
to connect to your service provider. You must make these
changes with the HPÊJornada dialup application.

To set or edit connection information in
Pocket Internet Explorer

1. In Pocket Internet Explorer, on the View menu,
click Options.

2. In the Options dialog box, on the AutoDial tab,
click AutoDial.

3. Choose the remote dial-up connection to be used.

4. Click Auto Disconnect if you wish to disconnect
automatically from the Internet after a specified
period of idle time.

5. Use the other Options tabs to set information such
as Appearance, Default Pages, Proxy Server,
and Advanced features.

6. When you are finished, click OK to save the
changes.

If you set up AutoDial in Pocket Internet Explorer, you can
connect to the Internet simply by starting the program and
entering the address of a Web site. (Be sure your phone line
is connected properly first.) If you prefer to dial up indepen-
dently of Pocket Internet Explorer, you may want to clear
the AutoDial option. To connect with the HPÊJornada
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dialup application, use the following procedure.

To browse the Web or your intranet

1. Double-click the HP dialup icon on your desktop.

2. In the HP dialup window, select a location and a
connection from the drop-down boxes, and then click
Continue.

3. In the Dial dialog box, confirm the user name and
password you use to connect to your ISP or network
and select the modem you will use to dial the call.

4. Check the phone number, and then click Dial. A
progress message appears to tell you when you are
connected to your ISP or network.

5. After you connect to your ISP or network account,
you may use Pocket Internet Explorer to browse.

If you did not use the HP Jornada dialup application to create your connection, you will
need to activate the connection you want in Remote Networking. On the Start menu,
point to Programs, point to Communication, and then click Remote
Networking. In the Remote Networking folder, double-click the icon of the connection
you want. Click Connect to begin dialing.

For more information about using Pocket Internet Explorer,
refer to online Help.
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Receiving your CompuServe mail

If you are a member of CompuServe, you can use Inbox to
receive your CompuServe e-mail on your HPÊJornada. To do
this, you will need to:

• Use the Web browser and Internet account on your
desktop PC (partner) to go to the CompuServe Web site
at www.csi.com/communications.

• Follow the instructions that are provided at that site for
creating a POP3 mailbox. Be sure to choose a mailbox
password that your HP Jornada can support (that is,
clear text).

• Create a connection with the HP Jornada dialup applica-
tion on your HP Jornada. You will have all the account
information you need when you finish creating your
POP3 mailbox at the CompuServe site.

• Set up (and name) the Inbox mail service connection. See
the Using Inbox section in this chapter.

After you have completed these initial setup procedures, you
will be able to send and receive your CompuServe e-mail just
as you would with any other Internet e-mail account.
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Your HP Jornada 820 or 820e Handheld PC (H/PC) works
perfectly as a standalone computer. But to get the most out of
your HP Jornada, you will want to connect to your desktop or
notebook PC. This chapter describes how to establish a
connection between your HP Jornada and a desktop PC, and
how to use your HP Jornada with a desktop PC—or with any
PC that has Microsoft® Windows® CE Services installed.
You will learn to:

• Connect to your desktop PC

• Set up Windows CE Services
• Establish a partnership between your HP Jornada and

your desktop PC
• Use Windows CE Services to browse the contents of your

HP Jornada
• Synchronize Microsoft Pocket Outlook data and e-mail

messages with Microsoft Outlook or Schedule+ and
Exchange

• Transfer files between your HP Jornada and desktop PC
• Connect to and transfer files between your HP Jornada

and a corporate network or home desktop PC over the
Internet or by modem

desktop PC
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Connecting for the first time
You can connect to a desktop PC using your HP Jornada
serial port, or you can connect to an infrared-equipped
desktop or notebook PC using the infrared port. Before you
connect, you must install Windows CE Services on the
desktop PC. Then, you can connect your HP Jornada to your
desktop PC with the sync cable, the infrared port, or a
network connection, and establish a partnership.

Setting up Windows CE Services
and establishing a partnership

Microsoft Windows CE Services with ActiveSync™ enables
you to synchronize the information on your desktop PC with
the information on your device. Synchronization compares
the data on your device with your desktop PC and updates
both computers with the most recent information. For
example:

• Keep your Pocket Outlook data current by synchronizing
your mobile device with your choice of Microsoft Outlook
(Inbox synchronization with Outlook Express is not
currently supported), Microsoft Schedule+, or Microsoft
Exchange on your desktop PC.

• Synchronize Word and Excel documents, Access and other
ODBC databases and tables, and InkWriter documents
between your device and desktop PC. Your files are
automatically converted to the correct format.

With Windows CE Services, you can:

• Back up and restore your HP Jornada data
• Add and remove programs on your HP Jornada
• Move and copy files (rather than synchronize files)

between your device and your desktop PC

Windows CE Services includes several components. The
Windows CE Services Setup Wizard detects which software
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components are needed and prompts you to set up only the
necessary components. For instance:

• If you do not already have Outlook or Schedule+
installed, the Setup Wizard will attempt to install
Schedule+ version 7.0a.

• The Setup Wizard can add Inbox extensions to enable
you to transfer messages to your desktop mail client—
Exchange or Outlook.

You may need to restart your PC after installing each
component.

The Desktop Software for Microsoft Windows CE compact
disc includes the following software options for your
desktop PC.

• Windows CE Services—Allows you to connect your
HPÊJornada to a desktop or notebook PC running
Windows 95 or Windows NT.
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• Microsoft Exchange Update—Adds an option to the Tools
menu in Microsoft Exchange, allowing you to synchronize
your HP Jornada Inbox with your Windows Inbox.

• Microsoft Schedule+ 7.0a—A schedule management
program for Windows 95 or NT.

• Ethernet Components—Network drivers for your
Windows CE.

• Microsoft Pocket Streets—A maps-and-navigation
program for Windows CE.

• WindowsÊ95 infrared drivers version 2.0—Allow you
to install an infrared port on a desktop PC.

• WindowsÊ95 Dial-Up Networking version 1.2 upgrade—
Allows you to establish a remote connection to your
desktop PC by modem.

• Microsoft Internet Explorer version 4.01—The most
recent version of the Internet browser for Windows 95
or Windows NT.

• WindowsÊNT Service Pack 3—System updates for
Windows NT.

There are many Windows CE programs available, including freeware and shareware. Go to
www.microsoft.com/windowsce, or try searching the Web on the keyword “Windows CE” to
find additional programs for your device.

Installing Windows CE Services

The minimum PC requirements for running Windows CE
Services are as follows:

• Microsoft Windows NT Workstation 4.0 or Windows 95
(or later)

• Desktop PC with a 486/33DX or higher processor
(Pentium® P90 recommended)

• 8 MB of memory (12 MB recommended) for Windows 95
(or later), and 16 MB of memory (32MB recommended) for
Windows NT Workstation
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• Hard disk drive with 10 to 50 MB of available hard disk
space (actual requirements will vary, based on selection of
features and current system configuration)

• Available 9-pin serial communications port
• CD-ROM drive
• VGA or higher resolution graphics card (SVGA 256-color

recommended)

To install Windows CE Services

1. Insert the Desktop Software for Microsoft
WindowsÊCE compact disc into the CD-ROM
drive on your desktop PC.

2. The Windows CE Services Setup Wizard should start
automatically. If it does not start, click Run on the
Start menu, and then type d:\setup, where d is the
letter assigned to your CD-ROM drive.

3. Follow the instructions that appear on your screen to
set up Windows CE Services, and then restart your
desktop PC.

4. After you restart your PC, the Windows CE
Services Get Connected dialog box appears,
prompting you to connect your HP Jornada.

• If you connect using the sync cable, connect
your device as described in the next section,
Connecting by sync cable, and then click
Start.

• If you connect by infrared, click Cancel, and
skip to the section Connecting by infrared,
later in this chapter.
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Connecting by sync cable

The HP Jornada uses a serial connection to communicate
with a desktop PC. The serial connection is established with
the sync cable that was included with your HPÊJornada and
a 9-pin serial communications port on your desktop PC.

If you do not have a 9-pin serial port on your desktop PC, or
if the port is in use by another device, such as a printer or
modem, you may need to obtain an adapter from your
computer manufacturer.

To connect your HP Jornada to your desktop PC

1. Insert the 9-pin end of the sync cable into a
serial port on your desktop PC.

2. Fully insert the flat end of the sync cable,
arrow side up, into the serial port on the
right side of your HP Jornada.

Fully insert the flat end of the sync cable, arrow side up,
into the serial port.
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Establishing a partnership

After you set up Windows CE Services on your desktop PC,
you are prompted to establish a partnership between your
desktop PC and your HP Jornada. The partnership enables
your desktop PC to recognize your HP Jornada when trans-
ferring files or synchronizing data.

You can establish partnerships between your HP Jornada
and up to two desktop PCs (for example, your home PC and
your office PC). A single desktop PC can partner with any
number of H/PCs or palm-size PCs. This is useful if you have
more than one computer running WindowsÊCE, or if several
mobile professionals share a single desktop PC.

Following the New Partnership Wizard

The New Partnership Wizard will help you create a partner-
ship and offer you options for synchronizing Pocket Outlook
data, e-mail messages, and files between your HPÊJornada
and desktop PC. When the New Mobile Device Detected
dialog box appears on your desktop PC, click Synchronize,
and then follow the instructions on the screen of your desktop
PC to complete the New Partnership Wizard.

The wizard prompts you to type a name and a description for
your HP Jornada. The name can be anything you choose (up
to 15 alphanumeric characters, no spaces) and should provide
an easy way for you to identify your HP Jornada. The
description could be the make and model of the device (e.g.,
HP Jornada 820 H/PC) or a property control number.

You can later change the device name and description using the Communications control
panel on your HP Jornada. On the Start menu, point to Settings, click Control
Panel, and then double-click the Communications icon.

The wizard also prompts you to choose settings for synchroni-
zation. If you choose to enable synchronization, you can set
ActiveSync either to synchronize automatically each time
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you connect your HP Jornada to your desktop PC, or to
synchronize continuously—whenever the synchronized
information changes, for as long as the computers are
connected.

Regardless of the options you choose while completing the wizard, you can also
synchronize at any moment by choosing the Synchronize Now command from the
Tools menu of the Mobile Devices window. For more information, see the Synchronizing
data section in this chapter.

Troubleshooting partnerships

If you are unable to establish a connection between
your HP Jornada and your desktop PC, double-click the
connection icon in the status area of the taskbar on your
HPÊJornada. The Connection Status dialog box may
provide information about the problem.

You should also confirm that both the desktop PC and the
HP Jornada are communicating at the same baud rate. To
check the baud rate on your desktop PC, click Communica-
tions on the File menu of the Mobile Devices window. You
can check and change the baud rate on your HPÊJornada
using the Communications control panel. On the Start
menu, point to Settings, click Control Panel, and then
double-click the Communications icon.

Baud rate

Connection
icon
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Verify that the sync cable from your HP Jornada is con-
nected to the port listed on the Communications tab
of the Windows CE Services Properties dialog box
(this is the port you selected when setting up Windows CE
Services), as shown in the following figure.

If these steps fail to correct the problem, use the Windows CE
Services Communications Troubleshooter. The Communica-
tions Troubleshooter provides detailed diagnostic steps to
identify and correct common problems.

To start the Communications Troubleshooter

1. On the Start menu of your desktop PC, point to
Microsoft Windows CE Services, and click
Mobile Devices.

2. On the Help menu in the Mobile Devices window,
click Communications Troubleshooter.
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Connecting to your desktop partner
After you have established a partnership, you have several
options for connecting your device to your desktop partner in
the future. You can set Windows CE Services to automati-
cally detect your HP Jornada and establish a connection
whenever you connect the sync cable. Using the COM port on
your desktop PC is the easiest way for you to connect, unless
you use that port for other peripherals.

To enable automatic connection

1. On the Start menu of your desktop PC, point to
Microsoft Windows CE Services, and click
Mobile Devices.

2. On the File menu in the Mobile Devices window,
click Communications.

3. Under Device Connections via Serial Port, click
Enable Auto Connect.

If you use the COM port of your desktop PC for other devices,
or if you have disconnected your HP Jornada and need to re-
establish the connection, you can establish a manual connec-
tion using the PC Link program on your HPÊJornada.

To connect manually

1. On the HP Jornada Start menu, point to
Programs, point to Communications,
and then click PC Link. The Connection Status
dialog box appears. After a few moments a sound
indicates that the connection has been established.
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To close the connection

1. On your HP Jornada, double-click the connection
icon in the status area of the task bar.

2. In the Connection Status dialog box, click
Disconnect.

Connecting by infrared

You can use the infrared port on your HP Jornada to
connect to a desktop or notebook PC that is running
WindowsÊ95 (or later). Once connected, you can transfer files
and synchronize Pocket Outlook data and e-mail messages
just as if you had connected using the sync cable.

Before you can connect by infrared, you must set up and
configure an infrared port on your desktop or notebook PC.
Many notebook PCs have a built-in infrared port; however,
you may need to install a third-party infrared transceiver on
your desktop PC. For more information about installing and
configuring that device for use with your desktop PC, refer to
the instructions that came with your infrared port .

The Desktop Software for Microsoft Windows CE compact disc
also includes infrared device drivers for Windows 95.

To configure Windows CE Services for infrared connection

1. Insert the Desktop Software for Microsoft
WindowsÊCE compact disc into the CD-ROM
drive on your desktop PC, and then run Setup.exe.

2. Click Optional Components, and then select
the Windows 95 Communications Driver setup
program.

3. When the setup program prompts you to specify
a communications port, select a virtual port
(typically COM3).

Connection
icon
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4. When setup is complete, restart your desktop PC,
and then open the Mobile Devices window.

5. In the Mobile Devices window, click
Communications on the File menu.

6. Under Port, select the infrared port you installed
when you set up the infrared device.
–or–
Click New to install the port. (If you install a
new port, you may need to reinstall WindowsÊCE
Services.)

To configure your HP Jornada for infrared connection

1. On your HP Jornada Start menu, point to
Settings, click Control Panel, and then
double-click the Communications icon.

2. On the PC Connection tab, if it does not say
Connect using Infrared Port, click Change,
and then select Infrared Port from the list of
available connections.

To establish an infrared connection

1. Line up the infrared port on your HP Jornada with
the infrared device on your notebook or desktop PC.

2. On your HP Jornada Start menu, point to
Programs, point to Communications, and
then click PC Link.

Connecting to another PC
In some cases, you may need to connect your HP Jornada to
a desktop PC other than your partner. Or, there may be
times when your desktop PC does not recognize your
HPÊJornada as its partner. This occurs if you have logged on
to the desktop PC with a different user name or if you

Chapter4.p65 0109 2/4/99, 4:10 PM76



Chapter 4 | Connecting to your desktop PC     | 77

performed a full reset of your HP Jornada by removing all
power or allowing the batteries to die.

In these cases, when you connect your HP Jornada to a PC,
the New Mobile Device Detected dialog box appears,
offering you the option to Synchronize, Browse, or to Restore
data from an existing backup file.

If you choose Synchronize, the New Partnership Wizard
will begin, and your HP Jornada will be designated as a
partner of the desktop PC.

If you choose Browse, your HP Jornada will be connected as
a “guest.” As a guest, you can view files and folders on the
HP Jornada, transfer files and folders, and manually back up
or restore. However, you cannot synchronize data or auto-
matically back up and restore data.

If you choose Restore, you are given the option to restore
data from an existing backup file on the desktop PC. Restor-
ing data in this way will replace all existing data on the
HPÊJornada with the data in the backup file on your PC.

If you have lost your HP Jornada or replaced it with another HP Jornada, you can use the
Restore function to set up a new device with the exact same data and settings as the old
one, provided you have previously performed a full backup to the desktop PC. When you
connect the new device to your desktop PC for the first time, choose Restore rather than
Synchronize or Browse. For more information, see the Backing up and restoring
data section in chapter 6.

Browsing your HP Jornada desktop
While your HP Jornada is connected to a desktop PC, you
can use Windows CE Services to browse the contents of your
HP Jornada from your desktop. Your HP Jornada appears as
an icon in the Mobile Devices window on your desktop PC.
When you double-click the HP Jornada icon, the contents of
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your HP Jornada are displayed as any other folder on your
desktop PC. You can cut, paste, and copy files between
folders on your HP Jornada, or transfer files between your
HP Jornada and your desktop PC, simply by dragging the
file icons between the appropriate folders.

For more information about transferring files, including details on converting file types
between Pocket Office and Office 97 programs, see the Transferring files section later
in this chapter.

You cannot open files or start programs stored on your
HPÊJornada by double-clicking their icons in the Mobile
Devices window. When you double-click the icon for a file or
program that is stored on your HP Jornada, Windows CE
Services displays the properties for that file or program, as if
you had clicked Properties on the File menu.

The Mobile Devices window on your desktop PC displays
the contents of your HP Jornada (shown here with

Internet Explorer 4.0 Active Desktop).

Chapter4.p65 0109 2/4/99, 4:10 PM78



Chapter 4 | Connecting to your desktop PC     | 79

Synchronizing data
Windows CE Services with ActiveSync enables you to
synchronize data between your HP Jornada and desktop
PC, so the names you add to your Contacts database and
the appointments you add to your Calendar while traveling
can be automatically updated on your desktop PC when
you return. You can also synchronize messages in your
HPÊJornada Inbox with Microsoft Outlook or Microsoft
Exchange on your desktop PC. In addition, you can
synchronize files in the Synchronized Files folder on your
HPÊJornada with files in the My Documents folder
(WindowsÊ95) or Personal folder (WindowsÊNT) on your
desktop PC.

You can set ActiveSync either to synchronize automatically
each time you connect your HP Jornada to your desktop PC,
or to synchronize continuously whenever the synchronized
information changes, for as long as the computers are
connected. You can also synchronize at any moment by
choosing Synchronize Now from the Tools menu in the
Mobile Devices window.

Synchronizing selected data

You can choose some or all of the following items to be
synchronized:

• Pocket Outlook data—Synchronize the Calendar,
Contacts, or Tasks information on your HP Jornada
with information stored in Outlook or Schedule+ on
your desktop PC.

• E-mail messages—Share messages between selected
folders in your HP Jornada Inbox and Exchange or Out-
look on your desktop PC.

• Files—Synchronize the contents of the Synchronized Files
folder (inside My Documents) on your HP Jornada with
files stored in your Windows 95 My Documents folder or in
your Windows NT Personal folder on your desktop PC.
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To specify data to synchronize

1. On your desktop PC, open the Mobile Devices
window, and then select your HP Jornada icon.

2. On the Tools menu, click ActiveSync Options.

3. On the General tab of the ActiveSync Options
dialog box, select the check boxes beside the services
you want to synchronize.

4. To set specific options (for example, to indicate how
many weeks of Calendar data to synchronize, or to
synchronize only active tasks), select the appropri-
ate service, and then click Options.

Reducing the amount of data to synchronize, for example, by synchronizing only 1 or
2 weeks of Calendar data, can significantly speed up the synchronization process. If you
use Microsoft Outlook, Windows CE Services synchronizes only 2 weeks of calendar data by
default.

Resolving synchronization conflicts

If the same item (for example, an appointment or a task)
has been modified on both the desktop PC and on the
HPÊJornada, ActiveSync will indicate that a Synchroniza-
tion conflict has occurred. When the Resolve Conflicts
dialog box appears, as shown in the following figure, you
can either resolve the conflict by selecting one of the items
to replace or you can ignore the conflict.
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You can resolve each conflict manually, at the time of
synchronization, or you can resolve conflicts automatically by
setting a default option for conflict resolution.

To set a default option for conflict resolution

1. Open the Mobile Devices window, and then select
your HP Jornada icon.

2. On the Tools menu, click ActiveSync Options.

3. On the General tab of the ActiveSync Options
dialog box, click Advanced.

4. Select the option you prefer to resolve conflicts.

Synchronizing from a remote location

The ActiveSync program on your HP Jornada enables you to
synchronize files, e-mail messages, and Pocket Outlook data
with your desktop PC, even when you are away from the
office. You can do this by remote dial-up connection or LAN
connection to your desktop PC. You can also connect to a
computer not on a network (such as your home computer)
and synchronize using a modem.
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Before you can synchronize remotely, the desktop PC or
network server must be configured for Remote Access
Services (Windows NT) or Dial-Up Networking (Windows
95 or later), and you must create a connection on your
HPÊJornada using either the HP Jornada dialup applica-
tion or the Remote Networking program. For information
about setting up connections with the HP Jornada dialup
application, see the Setting up a remote connection to
your network section in chapter 3. For Remote Network-
ing information, see the Accessing a computer not on
your network section in this chapter. After you have set
up for either type of connection, you can synchronize data.
See the To start remote synchronization procedure
later in this chapter.

Accessing a computer on your corporate network

To access a PC on your corporate network remotely, you
must have an account provided by your network administra-
tor, and you must set up a connection to your network server
using the HP Jornada dialup application (see chapter 3). In
addition, you must set up the target PC to receive your calls
as follows.

• The target PC must be turned on.

• Windows CE Services must be set up on the target PC.
(See the Installing Windows CE Services section
earlier in this chapter.) Also, the Auto Connect option
should be set to At all times.

• Windows CE Services must be running, and the Waiting
for mobile device to connect status message must be
shown in the Mobile Devices window.

• In the Windows CE Properties dialog box, Enable a
network connection must be selected.

• Any folders or drives you want to access must be shared.

If you will be dialing in to a desktop PC running Windows 95, you must also have Dial-up
Networking components set up on the target desktop PC.
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Accessing a computer not on your network

If you want to dial in to a computer that is not on a net-
work (such as your home PC with Microsoft Windows 95
and Microsoft Plus! pack), you must set up the target PC to
receive your calls as follows.

• The target desktop PC must be turned on.
• The target desktop PC must have a modem installed and

configured and must be set to receive incoming calls.
(Refer to the instructions from the manufacturer of your
desktop PC modem.)

• Dial-up Networking (Windows 95) or Remote Access
Service (Windows NT) must be set up and configured so
that your target PC can act as a server. (See your Win-
dows documentation for further instructions.)

• Windows CE Services must be set up on the target PC
(for instructions, see the Installing WindowsÊCE
Services section in this chapter). The Auto Connect
option should be set to At all times, also.

• Windows CE Services must be running, and the Waiting
for mobile device to connect status message should
appear in the Mobile Devices window.

• In the Windows CE Properties dialog box, Enable a
network connection must be selected.

• Any folders or drives you want to access must be shared.

The only information you need to establish a remote network-
ing connection is:

• Your Windows user name and password, if you are re-
quired to log on to your computer.

• Telephone number of the modem.

To create a connection to a computer not on a network
(such as a home computer), you will need to create a new
connection using Remote Networking on your HP Jornada.
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To create a Remote Networking connection

1. On the Start menu, point to Programs, point to
Communication, and then click
Remote Networking.

2. In the Remote Networking folder, double-click
Make New Connection.

3. In the Make New Connection dialog box, click
Dial-up, and then click Next.

4. If you have the HP Jornada 820, select the Built-
In Modem from the list of modems. If you have the
HP Jornada 820e, select the appropriate option for
the modem you have installed.

5. Click TCP/IP Settings, and then click General.
Make sure the Use Server-assigned IP Address
check box is selected.

6. On the Name Servers tab, click Server-assigned
addresses, and then click OK.

7. Click Next and fill in the phone number you wish to
dial. Click Finish. Now, a new icon appears, labeled
with the name you chose, in your Remote Network-
ing folder. This connection will also appear in your
remote synchronization dialog box.

To set a dialing location for a Remote Networking connection, double-click the icon for the
connection in the Remote Networking folder. In the Dial-up Connection dialog box,
click Dial Properties, and then fill in the information as you would for a network or
ISP connection using the HP Jornada dialup application.

To start remote synchronization

1. On your HP Jornada Start menu, point to
Programs, point to Communication, and then
click ActiveSync.
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2. If you are connecting using a modem or dial-up
connection, select the connection you will use from
the list. All connections you have created either with
the HP Jornada dialup application or Remote Net-
working will appear in this list.
–or–
If you are connecting over a network, click
Network Connection.

3. In the Connect to list, select the name of the
desktop PC to which you will connect. The
Connect to list displays only the PCs with
which you have already established a partnership.

4. In the User Logon dialog box, type your user name,
password, and domain if necessary, and then click
Connect.

Transferring files
You can copy files between your HP Jornada and desktop PC
by dragging icons to or from the HP Jornada icon in the
Mobile Devices window or by using the Cut, Copy, and
Paste commands on the Edit menu.

Some files may also need to be converted before you can use
them on your HP Jornada. For example, files created in
Office 97 programs must be converted before they can be
opened by the corresponding Pocket Office program (and vice
versa). By default, Windows CE Services automatically
converts files to the appropriate file type. However, you can
choose not to convert files, or you can specify the conversions
for each type of file by changing options in the File Conver-
sion Properties dialog box.

To set file conversion options

1. Open the Mobile Devices window.

2. On the Tools menu, click File Conversion.
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3. Click either the Device to Desktop or
Desktop to Device tab.

4. Select the file type, and click Edit to change conver-
sion options. In most cases, you will be offered a
single conversion option or no conversion at all.

When converting files between certain file types, such as
between Microsoft Word (.doc) and Pocket Word (.pwd) or
between Microsoft Excel (.xls) and Pocket Excel (.pxl), certain
formatting or attributes may be lost. For specific details, see
the sections on Microsoft Office programs in chapterÊ6 or
refer to online Help for that program on your HP Jornada.
Only Microsoft PowerPoint 97 files can be converted to
Pocket PowerPoint.

Transferring PIM data from older palmtop PCs
If you have an older palmtop PC, you can transfer personal
information manager (PIM) data  (contacts, calendar, and
task data) to your HP Jornada, saving you the task of re-
entering entire lists of contacts or tasks. You can also copy
all files, folders, and programs you have added from an older
model Windows CE device to your HP Jornada.

The transfer process you follow and the type of data that can
be migrated depends on the make and model of the palmtop
PC, and whether it uses WindowsÊCE Services to connect to
your desktop PC.

Migrating data from older Windows CE palmtop PCs

If your data is stored on a palmtop PC that uses an older
version of Windows CE, you must first back up the data to
your desktop PC using the version of WindowsÊCE Services
or H/PCÊExplorer that came with the device. Then, upgrade
to WindowsÊCE Services 2.2 on your desktop PC, and restore
the data to your HP Jornada. Use the following procedure to
migrate files, appointments, and other personal data stored
on your old palmtop PC.
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The following procedure will replace all files, programs, and Pocket Outlook data you have
added to your HP Jornada with the information stored on the palmtop PC.

To migrate data from an older Windows CE device to
your HP Jornada

1. Connect the older Windows CE palmtop PC to the
desktop PC and establish a partnership between the
two.

2. Synchronize the palmtop PC with the desktop PC
using H/PC Explorer 1.0 or Windows CE Services.

3. Perform a full backup of your data:

• On your desktop PC Tools menu in the Mobile
Device window, click Backup/Restore.

• In the window that appears, on the Backup tab,
select the options you prefer.

• Click Backup Now to initiate the process.

• Note the directory in which your data has been
saved.

4. Note the Communications, Owner, and World
Clock alarm settings on your palmtop PC. Also
note Options and User Preferences settings for
third-party programs. (These settings are not
restored automatically.)

5. Disconnect the palmtop PC.

6. If H/PC Explorer version 1.0 is set up on your
desktop, uninstall it using the Remove Programs
control panel. (For more information, refer to
online Help on your desktop PC.)
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7. Insert the Desktop Software for Microsoft
WindowsÊCE compact disc that came with your
HPÊJornada, and set up Windows CE Services 2.2.
(For more information, see the Installing
WindowsÊCE Services section in this chapter.)

8. Connect your HP Jornada to the desktop PC.

9. In the New Mobile Device Detected dialog box,
click Restore to restore data to your HP Jornada
from the backup file created in step 3.

10. Disconnect the sync cable on your HP Jornada,
and then press the reset button on your HP Jornada
to complete the restoration operation.

11. Reconnect the sync cable to your HP Jornada to
reconnect to the desktop PC. In the New Mobile
Device Detected dialog box, click Synchronize to
establish a partnership and synchronize your data.

Migrating data from non–Windows CE palmtops

If your data is stored on an HP 100/200LX Palmtop PC or
an HP OmniGo Organizer, you must first transfer the data
to your desktop PC. Use the Hewlett-Packard PIM Transla-
tion Utility (for HP devices only) to import the data into
Schedule+ 7.0a on your desktop PC. After you have
imported the data into Schedule+, you can update the
information on your HPÊJornada by synchronizing with
Schedule+ using Windows CE Services 2.2.

The English HP PIM Translation Utility is available on the
HP Jornada Handheld PC compact disc included with your
HP Jornada and at www.hp.com/cposupport/
handheld_compusers/software/setup.exe.html. This proce-
dure migrates only Phone Book and Appointment Book
data.
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Before translating PIM data files, you must install the version of Schedule+ 7.0a found
on the Desktop Software for Microsoft Windows CE compact disc on your desktop PC.

To install the HP PIM Translation Utility onto the
desktop PC using the HP Jornada compact disc

1. Insert the HP Jornada compact disc into the
CD-ROM drive on your desktop PC.

2. On the main menu of the HP Jornada  compact disc
installation screen, click HP PIM Translation
Utility.

PIM data translation

You can translate only one file at a time. To translate
multiple PIM data files, you need to repeat the Translation
operation for each file separately.

To translate appointment data

1. Double-click the HP PIM Translation Utility
icon to start the program.

2. In the Welcome screen, click Appointments.

3. In the Open File dialog box that appears, specify the
appointment data file to translate, and then click
OK. If the file you specify is not a PIM database file
of the appropriate type, you will get an error mes-
sage.

4. In the Appointment Book Translation Note screen,
click OK. The Data Translation Progress screen
appears, showing the progress of current translation
activity.

5. When the translation has successfully completed,
a message appears. Click OK to return to the
Welcome screen.
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Limitation on appointment translation

Although the Appointment Book applications on the
HPÊ100LX/200LX palmtop PCs and HP OmniGo 100/120
organizers and the Calendar application on the HPÊPalmtop
PC support daily, weekly, monthly, and yearly repeated
events, the Schedule+ application supports only daily and
yearly repeated events. Because all translation goes through
Schedule+, there is no direct mapping from earlier HP
Palmtop products to Schedule+ for repeating weekly and
monthly events. As long as you do not edit imported repeat-
ing weekly or monthly events in Schedule+ before you
synchronize them with the HP Palmtop PC, they will
translate correctly into repeating events on the palmtop PC.
If, however, you edit them in Schedule+, they lose their
weekly/monthly attribute and are treated as single events.

To translate a Phone Book data file

1. Double-click the HP PIM Translation Utility icon to
start the program.

2. In the Welcome screen, click Phone Book.

3. In the Open File dialog box, specify the phone book
data file to translate, and then click OK.

4. In the Phone Book Translation Field Map window,
select mapping options. For more information, see
the sections below.

5. When translation is complete, a message appears.
Click OK to return to the Welcome screen.

Phone Book field mapping

The HP PIM Translation Utility attempts to map the
fields in your Phone Book data file to standard fields in a
Schedule+ record. As long as your Phone Book fields have
standard names (that is, you have not modified the Phone
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Book database field structure), the translation is straight-
forward. The suggested mapping appears in a table in the
Phone Book Translation Field Map screen:

• The left column shows the names of fields extracted from
the Phone Book data file. (Only the fields that have data
are included.)

• The right column shows the names of Schedule+ fields.
• An arrow in the center column indicates that the data in a

Phone Book field in the left column will be copied to the
corresponding Schedule+ field in the right column. Note
that multiple Phone Book fields (for example, Address1
and Address2) can be mapped to the same Schedule+ field
(for example, Business address). No arrow in the center
column indicates that there is no mapping and, therefore,
the data will not be copied.

You can add or modify the suggested mappings before trans-
lating the data. For example, if you have customized the
name of a Phone Book field so that the HP PIM Translation
Utility does not know how to map it, you can define a
mapping for it yourself.

Name mapping

The Name field in the Phone Book data file can be mapped
in three ways in Schedule+:

• If the name in the Phone Book data file is entered as
Name1, Name2 [Name3] (that is, with a comma after the
first word), it is always mapped to the two name fields in
Schedule+ with Name1 = Last Name and Name2 [Name3]
= First Name.

• If the name in the Phone Book data file does not have a
comma after the first word, you can choose one of two
options for its mapping:
• Last name/First name - (default) Name1 [Name3]

Name2 maps to Name1 = = Last Name and [Name3]
Name2 = First Name.
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• First name/Last name - Name1 [Name3] Name2 maps
to Name1 [Name3] = First Name and Name2 = Last
Name.

In all cases, Last name is mapped to a single word, with any
additional words such as [Name3] becoming part of First
name.

Mapping additions

If a field appears in the left column with no mapping (that is,
no arrow in the center column) select a field name from the
drop-down list of the Schedule+ field immediately to the right
of the field whose mapping you want to define. The field name
appears in the appropriate cell in the right column and a
mapping arrow appears in the center column.

Mapping changes

If a field in the left column is mapped to the wrong field in
the right column, change the mapping by selecting a differ-
ent Schedule+ field name from the drop-down list for the
corresponding cell in the right column.

Mapping removal

If a field in the left column should not be mapped to any-
thing, click None from the drop-down list for the correspond-
ing cell in the right column. The None option is not avail-
able for the Name field.

Translation status review

After each translation is finished, whether it completed
successfully or was interrupted, the results are written onto
the Status screen. Click the Status button on the Welcome
screen to see the history of any translations begun during the
current execution of the HP PIM Translation Utility.
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Your Hewlett-Packard Jornada 820 or 820e Handheld PC
comes with a variety of programs designed to help you
stay organized. Use Microsoft® Pocket Outlook™ and
HPÊJornada viewer to manage your contacts, tasks, and
calendar while you are away from your office. When you
return, you can synchronize your HP Jornada with your
deπªtop or notebook PC to ensure that the Pocket Outlook
databases on your HP Jornada are always up to date with
the Microsoft Outlook or Schedule+ data on your desktop.

Pocket Outlook also lets you set alarms and reminders so you
never forget an appointment or meeting. And, if you want a
personal reminder, you can record voice memos to yourself
with Microsoft Voice Recorder.

In this chapterÊyou will find information about and basic
procedures for:

• Pocket Outlook

• HP Jornada viewer

• Voice Recorder

For more information on these and other programs that come
with your HP Jornada, see online Help.
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Using Microsoft Pocket Outlook
Your HP Jornada comes with Microsoft Pocket Outlook,
which includes Calendar, Contacts, Tasks, and Inbox. Using
Microsoft Windows® CE Services, you can synchronize
information on your HP Jornada with information in
Microsoft Outlook, Microsoft Schedule+, or Microsoft 
Exchange on your desktop computer. Each time you synchro-
nize, Windows CE Services compares the changes you made
on your device and desktop PC and updates both computers.

With Inbox, you can send and receive e-mail messages, either
through synchronization with the mail program on your
desktop PC (either Outlook or Exchange) or by connecting
directly to your mail server through an Internet or network
account.

Keeping appointments with Calendar

Use the Calendar program to schedule appointments, meet-
ings, and other events. Quickly check your appointments in
one of several views (Day, Week, Month, Year, and Agenda).

To create a new appointment

1. From any view, click New Appointment.

2. Enter a description and the location of your
appointment.

3. Select the time and date of your appointment.

4. To add notes, click Notes, and then click in the
notes area. Enter your notes.

5. To assign the appointment to a category, click
Categories and select a category from the list.

6. Select other desired options, and when you are
finished click OK.
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If you need to schedule a meeting with people who use
Outlook, Pocket Outlook, or Schedule+, you can use
Calendar to schedule the meeting. When attendees receive a
meeting request, they can choose to accept or decline the
meeting. If they accept, the meeting is automatically placed
in their schedule. In addition, their response is automatically
sent back to you, and your Calendar is updated.

Before you can send a meeting request, you must enter
e-mail addresses in Contacts and set up Inbox to send and
receive messages (see the Using Inbox section in chapter 3).

To create a meeting request

1. On the Tools menu, click Options, and then choose
a mail transport. If you send and receive messages
using synchronization, select ActiveSync. If you
connect to an ISP or network, select the service you
set up in Inbox or the HPÊJornada dialup application.

2. Click OK.

3. On the File menu, click Make Meeting.

4. Enter the meeting information.

5. Select the contacts you want to invite.

6. Select other desired options, and then click OK.

Inbox automatically creates a meeting request and sends it to
the attendees the next time you connect to your mail server
or synchronize with your desktop PC.

Your HP Jornada will remind you about your appointments and meetings by sounding
an alarm, flashing the notification LED, or displaying a message on the screen. To choose
the way you prefer to be notified, on the Tools menu, click Options. Click Alarm
and then click Reminder Options. You can turn off your alarm without even
opening your HP Jornada by pressing the alarm notification LED on the cover.
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Managing names and addresses with Contacts

The Contacts program maintains a list of your friends and
colleagues so that you can easily find the information you are
looking for, whether you are at home or on the road. Using the
infrared port, you can also quickly share Contacts information
with other Windows CE–based mobile device users.

To create a new contact

1. In Contacts, click New Contact.

2. Enter a name.

3. Click Business or Personal and enter information
in the appropriate fields. Supply an e-mail address if
you want to send meeting requests and e-mail
messages to this contact.

4. To add a note or assign the contact to a category,
click Notes/Categories. Then, select the notes area
and enter your notes, or select a category
from the list.

5. When you are finished, click OK.

You can send up to 25 contact cards at a time to another Windows CE–based device. To
do this, line up the IR ports on the two devices so that they are within 1 meter (3 feet) of
one another. On the Contacts list, select the item(s) you want to send, and then on the
File menu, click Send. If you are receiving items, click Receive.

Keeping track of your workload with Tasks

The Tasks program helps you keep track of what you need to
do. Enter the details for a task on the task card, and then
assign a category. You can even associate a date with the
task and then set a reminder for yourself.
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You can sort the list on any column by clicking the column
heading (the column used for sorting the list displays a
triangle in the heading). If you sort by status, active tasks
are listed before completed tasks. Or, you can filter your list
to show only a specific status of a task or tasks belonging to a
specific category. When your list is filtered, the filter drop-
down list indicates which category is selected. Overdue tasks
are displayed in red, bold text.

To create a new task

1. In Tasks, click the New Task button.

2. Enter a description.

3. Select the start date, due date, and other
information.

4. To add notes, click Notes, and then click in the
Notes area. Enter your notes and click OK.

5. When you are finished, click OK.

Managing your e-mail with Inbox

Use Inbox to send and receive e-mail messages. You can
access your e-mail by synchronizing with your desktop PC
or by connecting to a mail server through an Internet or
network account. (Learn how to connect to your network or
ISP in chapter 3, and see the Using Inbox section of
chapter 3 for additional information.)

Click here to filter the Task list by category.
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Using HP Jornada viewer
HP Jornada viewer gives you a quick and versatile way to
view the information in your Pocket Outlook Calendar,
Contacts, and Tasks databases. HP Jornada viewer displays
the information you choose in as much detail as you like,
including detailed contact information, tasks and notes on a
single screen, or all the appointments and tasks scheduled
for a single day, a week, or up to 12 months at a time. Using
HP Jornada viewer also lets you to view a single field for any
record or to switch instantly to Pocket Outlook for editing.

By default, the HP Jornada viewer icon is displayed on the
Windows CE desktop.

To start HP Jornada viewer

1. On the Start menu, point to Programs, point to
HP Applications, and then click HP viewer.
–or–
Double-click the HP viewer icon on your
WindowsÊCE desktop.

You can change the font used for HP viewer by changing the setting in Pocket Internet
Explorer. Open Pocket Internet Explorer; on the View menu, click Fonts, and select the
size you want.
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HP Jornada viewer shows your Pocket Outlook information quickly.

You can quickly switch from HP Jornada viewer to
PocketÊOutlook to look at the selected date in all Calendar
views.

To switch to Pocket Outlook

1. On the Go menu, click the appropriate
program or view.

HP Jornada viewer displays the current date and your next
scheduled appointment below the toolbar in the Today
Banner of the HP Jornada viewer window.

• To quickly view detailed information about the appoint-
ment, click the appointment title in the Today Banner.

The Today Banner displays the date and
the next scheduled appointment.

Click an icon to switch between Tasks, Contacts, and
Calendar views.

View your
appointment
information.
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To switch between Calendar, Contacts, and
Task information

1. Click the appropriate icon on the left side of the
HPÊJornada viewer window.

Viewing Calendar information

HP Jornada viewer lets you view your calendar in Day,
Week, Month, or n-Month view.

n-Month

Month

Week

Day

Today (Goto Today command)

Date (Goto Date command)

Day View allows you to browse your schedule quickly for the
current day or up to 7 days that you select.

To enable Day Zoom in n-Month View, Month View, or Week
View, press the spacebar to display appointments and tasks
for the selected date(s). Click an icon next to an appointment
or event to expand a note or to display more information
about that appointment or event.

You can set HP Jornada viewer to always display Day Zoom for the date you select by
clicking the Day Zoom button  on the toolbar.

Chapter5.p65 0109 2/4/99, 4:38 PM100



Chapter 5 | Staying organized | 101

Week View enables you to display 1, 2, or 3 weeks of your
calendar at a time. Click   or   on the scroll bar
to increase or decrease the number of weeks displayed. Click
an event to display detailed information about that event.

Use Month View to display 6 weeks of data on a single
screen, or use n-Month View to display calendars for several
months at a time. Click a day to display detailed information
about appointments or events scheduled on that day.

Viewing Contacts information

HP Jornada viewer lets you view all information for a
particular contact on a single screen.

• Type in the Find File As box to display only contacts
matching the letter(s) you type.

• Click a tab on the left side of the contact list to jump to
contacts that begin with that letter. To jump to the second
letter on the tab, click the tab again.

• To change the field on which the contact list is sorted,
click the field name at the top of the list, and then select a
field from the Select Primary Key dialog box.

Viewing Task information

You can also use HP Jornada viewer to view task informa-
tion for any field, including Notes.

• Type in the Find Task box to display only tasks that
match the letter(s) you type.
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Recording voice memos
You can use Voice Recorder to record messages any time.
Voice memos do require large amounts of storage, so you
may need to take steps to conserve memory when using
the VoiceÊRecorder.

Using Voice Recorder

Quickly capture thoughts, reminders, ideas, and phone
numbers with Voice Recorder. You can create and listen
to your recordings using the HP hot key  on your device or
menus in the Voice Recorder program. (For more information
about how to use Voice Recorder, see online Help.)

To record and to play a recording

1. On the Start menu, point to Programs, point to
Accessories, and then click Voice Recorder.

2. Hold your HP Jornada so that the microphone is
near your mouth or the source of sound.

3. Click Record. You will hear a beep when
recording begins.

4. To stop recording, click Stop. The new recording
appears on the recording list.

5. To play a recording, double-click it on the recording
list. To pause playback, click Play/Pause. Click
Play/Pause again to resume playback.

You can play all of your recordings, one after another. Select the recording you want to
play first, click Control,,,,, and then click Play Sequential. The selected recording
and following recordings will be played. A short beep will sound between recordings.
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Conserving memory

Voice memos may consume large amounts of storage
memory on your HP Jornada. If you record or store lots of
voice memos, you may need to take steps to conserve
memory.

• Adjust the amount of storage memory available on
your HP Jornada using the Memory tab in the System
control panel.

• Add more memory to your device with a CompactFlash
Card or PC Card. (For a list of recommended cards, go to
the Hewlett-Packard Web site at www.hp.com/handheld.)

• Use HP Mobile Voice to store your voice memos in a
compressed format. You can choose Mobile Voice format
from the list of recording formats (in the Voice Recorder
program, on the Tools menu, click Recording Format).
This saves space, but lowers the quality of the recording,
so try to speak close to the microphone to increase clarity.
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Your Hewlett-Packard Jornada 820 or 820e Handheld PC
can help you stay productive and be efficient, even when you
are away from your desktop or notebook PC. You have access
to Microsoft® Pocket Office and other pre-installed programs
to help you calculate expenses and conduct searches. Your
HPÊJornada also includes the HP Jornada backup applica-
tion, which keeps things running smoothly.

In this chapter, you will learn more about:

• Microsoft Pocket Office, which includes:

• Microsoft Pocket Word

• Microsoft Pocket PowerPoint

• Microsoft Pocket Excel

• Microsoft Pocket Access

• HP Jornada show

• Microsoft InkWriter

• HP Jornada backup

• OmniSolve from LandWare

• bFAX from bSquare

• bFIND from bSquare

      to business
Getting down | 6
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Working with Microsoft Pocket Office
Microsoft Pocket Office makes it easy to work in the familiar
Office environment, even when you are away from your
desktop or notebook PC. You can start any of the
PocketÊOffice programs by double-clicking the appropriate
icon on the desktop or by pressing the appropriate
HPÊJornada hot key. For more detailed information about
these programs, see the Microsoft Pocket Office topic in
online Help.

Using Microsoft Pocket Word

You can create and edit documents (.pwd) or templates (.pwt)
in Pocket Word just as you do in Microsoft Word on your
desktop computer. Begin by placing the cursor in the docu-
ment page and start typing in either Outline or Normal
view. A spelling checker is provided to verify spelling accu-
racy, and you can quickly format text using buttons and
menu commands similar to those found in Microsoft Word on
your desktop PC. You can access international characters
and symbols for currencies on the Tools menu. If you share
documents with those who use other programs or those who
do not have a Windows®ÊCE device, you can save documents
in other file formats, such as .doc, .rtf, or .txt. The .rtf file
format will allow you to keep much of the same formatting,
while the .txt file format will strip out all formatting.

To create a document using Pocket Word

1. On the File menu, point to New, and then
click Document from Template.

2. Select a template, such as Meeting Notes,
and then click OK.

3. On the File menu, click Save.

4. Type a name for your file and click OK.

5. Replace the text in the template.
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To see more of your document, on the View menu, click Full Screen.

Using Microsoft Pocket PowerPoint

You can deliver professional online presentations with
PocketÊPowerPoint. Simply create the presentation in
Microsoft PowerPoint 97 on your desktop PC and transfer
the presentation to your device.

You can show the presentation directly on your device, or you
can connect your HP Jornada to a VGA monitor or a projec-
tor and show the presentation to a large group. This option
allows you to view PowerPoint speaker notes on the
HPÊJornada display while your presentation is showing on
the VGA-compatible monitor. Your Pocket PowerPoint file
will include the text, pictures, notes, and layout position of
the original Microsoft PowerPoint presentation, but it will
not include animations or slide transitions.

To show a presentation

1. Using Windows CE Services, copy the presentation
from your desktop PC to your HP Jornada.

2. On the Start menu, point to Programs, point to
Office, and click Microsoft Pocket PowerPoint.
–or–
Press the PowerPoint hot key.

3. In the Open Presentation dialog box, select the
presentation you want to show, and then click OK.

4. To change the presentation display and slide-advance
options, on the Tools menu, click Set Up Show.

5. To show the presentation, on the View menu, click
View Show. If you chose Manual under Presenta-
tion Display in step 4, use the Previous and Next
buttons to control the slides.

Chapter6.p65 0109 2/4/99, 4:17 PM107



108 | HP Jornada H/PC User’s Guide

You can tailor a presentation by adding a new title slide to your presentation. To do so,
click Title Slide on the Tools menu.

The external monitor port uses significant power and can quickly drain your batteries.
Connect to AC power when using the external monitor port, or double-click the VGA Out
icon in the taskbar to disable the port when not in use.

To show a slide presentation on a
VGA-compatible monitor

1. Connect a standard VGA cable to the external
monitor port on the back of your HP Jornada and
to the VGA monitor.

2. Start PowerPoint, and open the presentation (see
To show a presentation earlier in this chapter).

3. On the Tools menu, click Set Up Show.

4. From the View Show On list, select one of the VGA
Out options.

5. To start the show, on the View menu, click
View Show.

External
monitor port
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You can make the monitor black out during a presentation. To do so, press the  key.
To make the screen fade to white, press the  key. Press the  or  key again to
resume the presentation.

Using Microsoft Pocket Excel

You can use Pocket Excel to create workbooks, such as
expense reports and mileage logs. You can also use Pocket
Excel to open and edit workbooks created using the desktop
version of Excel. When you are ready to save a workbook you
created or edited, you can save it in a variety of formats,
including Pocket Excel (.pxl) and Excel (.xls). If you plan to
send the document through e-mail to someone who will be
using Excel, not Pocket Excel, be sure to save it in the Excel
(.xls) format.

Pocket Excel provides fundamental spreadsheet tools, such as
formulas, functions, sorting, and filtering. You can split
panes to easily view different areas of a large worksheet. You
can also “freeze” the top and leftmost panes in a worksheet to
keep row and column labels or other data visible as you scroll
through a sheet.

To create a workbook using Pocket Excel

1. On the File menu, point to New, and click
Workbook from Template.

2. Select a template, such as Expense Report, and then
click OK.

3. On the File menu, click Save.

4. Type a name for your file, and then click OK.

5. Replace the text in the template.
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If your workbook contains sensitive information, you can protect it with a password. To do
so, open the workbook, and on the File menu, click Password. Password-protected
workbooks cannot be synchronized.

Using Microsoft Pocket Access

You can use Pocket Access to view and update data derived
from Microsoft Access, Microsoft SQL Server, and other
ODBC databases on your HP Jornada. You can open the
database and update data in the corresponding tables or you
can fill out electronic forms. Eventually, you should synchro-
nize the new information with a larger database on your
desktop PC or your corporate network. You can also use
Pocket Access to create new databases, tables, and SQL
procedures directly on your device.

Programmers can use Microsoft ActiveX® Data Objects for Windows CE (ADOCE) and
Microsoft Visual Basic® or Microsoft Visual C++® to develop custom database
solutions. For more information on creating custom database solutions, go to the
Microsoft Web site at www.microsoft.com/windowsce.

To create a new database and table

1. On the Start menu, point to Programs, point to
Office, and then click Microsoft Pocket Access.

2. On the View menu, click Database View,
and then on the File menu, click Open/New
Database.

3. Type a name for the database and click OK.

4. Double-click the Create a New Table icon.

5. In the Field Name box, type a name.
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6. From the Data Type list, select a data type.

• The data type of a field cannot be changed
after the table is saved.

• Text boxes have a size limit of 255 characters. To
enter longer notes, select the Memo data type.

• To enter numbers with decimal points,
select the Float data type.

• To enter numbers between -32,768 and
+32,767, select the Integer data type.

• To enter smaller numbers, select the Small
Integer data type.

7. To set the size limit of a field, enter an amount in the
Field Size box. You will not be able to change field
sizes after the table is saved.

8. To index the field, select Yes from the Indexed list.
Indexing a field allows Pocket Access to find and sort
information faster for that field.

9. Repeat these steps until you have created all the
fields you want for your table.

10. On the File menu, click Save Table.

If you have tables that you do not want to keep updated on the device (such as product
catalogs), mark them as read-only when transferring them from the desktop to the device
to save time during future synchronization sessions. Windows CE Services will not check for
updates the next time you synchronize.
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Printing your Pocket Office documents

You can print your Pocket Office and other documents from
your HP Jornada three different ways:

• By connecting via serial-to-parallel cable directly to a PCL
printer (language version 3 and above).

• By connecting via infrared port (only with an infrared-
equipped PCL printer).

• By transferring the file to your desktop PC and printing it
from within a program on the desktop PC.

To print directly to a printer with a serial cable connection

1. Connect your HP Jornada to your PCL printer with
a serial cable. (The HP Parallel Printer Cable is
available as an accessory.)

2. Start the program that you used to compose the
document if it is not currently running (Pocket
Word, for example).

3. On the File menu, click Print. The Print dialog
box appears.

4. Choose the printer you will be printing to and select
the COM1 port option.

5. Set other Print options as necessary.

6. Click OK.

Serial port
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To print directly to a printer with an infrared connection

1. Start the program that you used to compose
the document if it is not currently running
(Pocket Word, for example).

2. On the File menu, click Print. The Print dialog
box appears.

3. Choose the PCL printer you will be printing to and
select the IrDA port option.

4. Set other print options as necessary.

5. Click OK, and then line up the infrared port on your
HP Jornada with the infrared port on the printer.

Using HP Jornada show
The HP Jornada show application allows you to display your
HP Jornada screen image on a VGA–compatible monitor.
Using this option, you can use other Microsoft Pocket Office
products or third-party programs to create and display
presentations as well. HP Jornada show displays screen
resolution up to 640 x 480 at 256 colors.

To view your HP Jornada display on an external monitor

1. Use a standard VGA cable to connect a
VGA-compatible monitor to the external
monitor port on your HP Jornada.

2. On the Start menu, point to Programs, point to
HP Utilities, and then click HP show.

3. In the HP show dialog box, click OK.

While HP Jornada show is running, the external monitor
port is enabled, and the HP show icon and VGA On icon are
displayed in the taskbar.
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The external monitor port uses a significant amount of power and can quickly drain your
batteries. Connect to AC power when using the external monitor port, or double-click the
VGA Out icon in the taskbar to disable the port when not in use.

Using Microsoft InkWriter
Microsoft InkWriter®, a text, graphics, and ink processor
with Rich Ink technology, makes it easy for you to write and
draw the way you do on paper, but with the benefit of being
able to edit and format your writings and drawings. With
InkWriter, you can enter information in the way that is
easiest for you. You can type using the keyboard, or you can
draw using the HP Jornada touch pad.

To create an InkWriter document

1. On the Start menu, point to Programs, point to
Accessories, and then click InkWriter.

2. Create your document:

• To type, click Writing on the View menu,
and then use the keyboard.

• To draw, click Drawing on the View menu, and
then click and drag on the HP Jornada touch
pad to draw on the screen. You can also create a
drawing in Writing view by crossing three of the
ruled lines on the first stroke of
the drawing.

3. When you are finished, on the File menu,
click Save.

InkWriter can help you draw perfect circles, rectangles, triangles, and lines. To do this, in
Drawing view, select a shape you have drawn, and then on the File menu, click
Shapes  and choose a shape from the list.
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Backing up and restoring data
To prevent loss of data, you should back up your
HPÊJornada data frequently. You can back up your
HPÊJornada two convenient ways:

• Use Windows CE Services to back up all data to
your desktop PC.

• Use the HP Jornada backup application to back up all
data or Calendar, Task, and Contact (PIM) databases,
to a PC Card or CompactFlash Card.

Using Windows CE Services Backup at your PC

The Windows CE Services Backup feature creates a complete
duplicate of all data stored on your HP Jornada. If you
routinely connect to your desktop PC, this is the best method
of data backup. The backup file is saved on the hard disk of
your desktop PC.

When you restore data from a backup file created by
WindowsÊCE Services, all data on your HP Jornada is
replaced by the data in the backup file, including files you
have created, programs you have installed, and any system
settings and options you have set.

To access the Windows CE Services Backup feature, click
Backup on the Tools menu in the Mobile Devices window.
For more information about WindowsÊCE Services Backup,
see online Help.

Using HP Jornada backup

HP Jornada backup provides a convenient way to back up
Pocket Outlook data while you are traveling or while you are
away from your desktop PC. You can back up the informa-
tion to a PC Card or CompactFlash Card for secure storage.
You can also back up data to a folder on your HPÊJornada.
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However, this will not preserve the information if you lose
power or need to perform a full reset. (See the Resetting
section in chapterÊ8.)

To back up data

1. On the Start menu, point to Programs, point
to HP Applications, and click HPÊJornada
backup.

2. Click Backup.

3. Choose one of the backup options:

• Select Back up all data to back up all informa-
tion stored in RAM, including files you have
created, programs you have installed, and any
system settings and options you have set.

• Select Back up PIM databases to back up only
your Contacts, Tasks, and Calendar databases.

4. Follow the instructions on your screen to complete
the backup process.

If you have both a CompactFlash Card and a PC Card installed, two folders appear in the
My Handheld PC folder. The folder called Storage card represents the first card you
inserted, and a folder called Storage card 1 represents the next card that was inserted.
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To restore from a backup file

1. On the Start menu, point to Settings, and click
Control Panel.

2. Double-click the HP Jornada backup icon.

3. Click Restore all data or Restore PIM
databases.

4. Select the backup file you want to restore, and then
click Restore.

Your HP Jornada must have the same regional settings when you restore as you had when
you completed the backup. Otherwise, you will not be able to restore the files. To change
regional settings, on the Start menu, point to Settings, click Control Panel, and
then double-click the Regional Settings icon.

Using OmniSolve from LandWare
OmniSolve is a financial application designed specifically
for real estate, retail, and business professionals who use
palmtop PCs to make financial decisions quickly and accu-
rately. OmniSolve employs a “form filling” metaphor to
provide you with a rich problem-solving environment that
is unparalleled in its ease of use, power, and flexibility.

To start OmniSolve

1. Double-click the OmniSolve icon on the HPÊJornada
desktop.

For detailed procedures about using OmniSolve, refer to
online Help.
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Using bFAX Pro from bSquare
You can send and receive faxes with your HPÊJornada by
using bFAX™ Pro. bFAX Pro allows you to send documents
you have created in other programs, receive faxes and view
them as graphic files, and manage fax documents stored on
your HP Jornada. bFAX includes bVIEW, which enables you
to preview faxes before you send them. For detailed proce-
dures about using bFAX Pro and bVIEW, see online Help.

Starting bFAX Pro

Before you can send and receive faxes, you will need to
connect a phone line to your HP Jornada and configure
your modem. If you are using an external or PC Card
modem, follow the instructions included with the modem to
install and configure it for use with your HP Jornada.

You also need to set modem and dialing options in bFAX
Pro before you send or receive faxes for the first time. On
the Options menu, click Communications to set your
modem settings and dialing options.

For more information on connecting a phone line to your
HPÊJornada and setting dialing options, see the Connect
the phone line section in chapter 3.

To start bFAX Pro

1. On the Start menu, point to Programs, point to
Communication, and then click bFAX Pro.

Sending faxes

If  you want to send several faxes, send them one at a time
rather than all at once. The internal modem (model 820
only) might interrupt the transmission when several faxes
are sent at one time.
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To send faxes one at a time

1.  In bFAX Pro, select a fax you want to send.

2.  On the Fax menu, click Send Fax. Do not click
Send all Faxes in Outbox.

If sending is interrupted, you will need to perform a soft reset to disconnect the modem.
For more information, see the Resetting Resetting Resetting Resetting Resetting section in chapter 8 of the User’s Guide.

If you encounter difficulties sending faxes with bFAX Pro
while using the internal modem (model 820 only) make
sure you have selected the internal modem and then
disabled Class 1 fax support.

To select the internal modem and disable Class 1 fax
support

1. In bFAX Pro, on the Options menu, click
Communications.

2. From the Modem to use list, select
Built-in Modem on COM6.

3. Clear the Use Class 1 Fax Support check box.

If you are unable to send faxes with bFAX Pro while using
a PC Card modem:

• Ensure that the correct modem is selected. In bFAX Pro,
on the Options menu, click Communications, and then
select PC Card modem on COM2 from the Modem to use
list.

• Your Modem might require setup parameters or a
special initialization string. For more information abut
which modems require this, check the HP Web site at
www.hp.com/handheld.
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Using bFIND from bSquare
With bFIND™ you can search for a word or text string in
any database, file, file name, or e-mail message stored on
your HPÊJornada. Simply enter the characters you want to
search for in the initial bFIND dialog box, and bFIND
retrieves all occurrences of that string. bFIND is integrated
with existing programs, so, double-clicking one of the
search results within bFIND launches the program in
which the string was found, and opens the document
containing that search string.

bFIND includes default script files for the standard
WindowsÊCE programs, databases, and file types. These
script files help bFIND interpret search results and drive
other applications to complete the searches that are
started within bFIND. You can search any or all of the
following areas:

• E-mail messages

• Contacts, Appointments, and Tasks databases

• Other databases (Pocket Access databases, for example)

• File contents (including Pocket Word and Pocket Excel
files)

• File names (searches files and folders)

• bFAX packages

To start bFIND

1. On the Start menu, point to Programs, point to
Accessories, and then click bFIND.

For detailed procedures about using bFIND, see online Help.
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This chapterÊdescribes ways you can add to your
HPÊJornada Handheld PC (H/PC) and customize
Microsoft® Windows®ÊCE to suit your working style and
preferences. By exploring the different options, you can
find ways to become more efficient and to make working
with your HPÊJornada more comfortable and fun. This
chapterÊcovers:

• Adding to your HP Jornada—Including programs, fonts,
sounds, and bitmaps, and peripheral devices

• Fine-tuning performance—Using Control Panel to set
various options, including general system settings,
HPÊJornada hot keys, and settings that can increase
battery life

HP Jornada
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Adding to your HP Jornada
This section describes how to add functionality to your
HPÊJornada by installing software and adding peripherals
and storage cards. You will also learn how to customize the
WindowsÊCE desktop and working environment.

Installing programs

You can add even more functionality to your HP Jornada by
installing third-party software. A wide variety of commercial
software is available for Windows CE, ranging from custom
business applications to system utilities to games and
entertainment. Some programs are available on the
HPÊJornada compact disc and the Desktop Software for
Microsoft WindowsÊCE compact disc included with your
HPÊJornada. Other programs are available from software
distributors and on the Web.

You cannot run programs designed for Windows 95 or Windows NT on your HP Jornada.
The only programs that will run on your HP Jornada must be designed specifically for
Windows CE.

The HP Jornada compact disc includes many productivity-
enhancing programs, such as:

• Microsoft Java virtual machine, which enables you to run
cross-platform Java applications on your HP Jornada.

• TrueSync CE 2.0 from Starfish Software for synchronizing
your HP Jornada with the REX™ Classic and
REX™ Pro Cards.

Explore the HP Jornada compact disc to enjoy these free
software programs. For more information about a particular
program, go to the Web site of that program’s manufacturer.

Many other useful programs are available from the
Hewlett-Packard Web site at www.hp.com/handheld.
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To install software

1. Download the software program or installer from the
Web to your desktop PC.
–or–
Insert the floppy disk or compact disc into the
appropriate drive on your desktop PC.

2. Connect your HP Jornada to your desktop PC.

3. If the program includes an installer program (typi-
cally named Setup.exe or Install.exe), double-click
the installer program on the desktop PC. The in-
staller program will copy the necessary files to your
HP Jornada.
–or–
If the program does not have an associated installer
or setup program, drag the program file (typically an
*.exe file type) to the HP Jornada icon in the Mobile
Devices window. If the No converter selected
dialog box appears, click OK to copy the file without
conversion.

Install software by dragging the program file to the Mobile Devices window only if no
installer program is available. Software installed in this way may not appear on the
Remove Programs list, and you may have to delete the program manually if you wish to
remove it from your HP Jornada.

After you have installed a program on your HP Jornada, you
can use the Windows CE Application Manager to remove the
program or to reinstall the program after it has been re-
moved. If you do not have enough storage memory on your
HP Jornada, you may want to use the Application Manager
to temporarily remove programs you no longer use or pro-
grams that you use infrequently.
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To add or remove programs with Application Manager

1. Connect your HP Jornada to your desktop PC, and
then open the Mobile Devices window.

2. On the Tools menu in the Mobile Devices
window, click Application Manager.

3. In the list of programs, select the program you
wish to install, and then click Add.
–or–
Select the program you want to delete, and then click
Remove.

Removing programs

You can use either the Application Manager (on your desktop
PC) or the Remove Programs control panel (on your
HPÊJornada) to remove programs.

To remove a program from your HP Jornada with the
Remove Programs control panel

1. On the Start menu, point to Settings, and then
click Control Panel.

2. Double-click the Remove Programs icon.

3. From the Programs list, select the program you
want to remove.

4. Click Remove.

Programs stored in ROM cannot be removed. (For a list of these programs see the
Your␣ HP␣ Jornada programs section in chapter 1.)
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Adding fonts

Your HP Jornada comes with a selection of built-in fonts.
You can add Windows fonts (.fon files) or TrueType fonts (.ttf
files) to your HP Jornada for use in Pocket Word documents
and Pocket Excel spreadsheets. Because fonts take up a
significant amount of storage memory, install only the fonts
you need, and delete those you do not need. (The built-in fonts
cannot be deleted.)

To add fonts

1. Connect your HP Jornada to a desktop PC, and then
start Windows CE Services.

2. In Windows Explorer on the desktop PC, select the
font files you want to copy.

3. Drag the font files to the Windows folder on your HP
Jornada. If you are copying a Windows font, you will
be prompted to select the point sizes and styles you
want to copy.

Adding sounds

Your HP Jornada can play sounds (.wav files). You can
copy a Wave sound file from your desktop PC to your
HPÊJornada without converting the file. If you want to use a
sound as part of a sound scheme or to signal an alarm or a
reminder, copy the sound file to the Windows folder on your
HP Jornada. For more information, see the Setting Alarms
topic in online Help.
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Adding desktop wallpaper

Your HP Jornada can display 256-color bitmap images (.bmp
files) or Windows CE bitmaps (.2bp files). You can copy
bitmap images from your desktop PC to your HPÊJornada
without converting the files, and you can use these images as
desktop wallpaper on your Windows CE desktop.

To add desktop wallpaper

1. Connect your HP Jornada to a desktop PC and start
Windows CE Services.

2. Drag the bitmap image you want to copy from its
location on your desktop PC to the HP Jornada icon
in the Mobile Devices window.

3. On the HP Jornada Start menu, point to
Settings, and click Control Panel.

4. Double-click the Display icon.

5. On the Background tab, click Browse, and then
select the bitmap file to display as your background.

Adding peripherals

You can also enhance the functionality of your HP Jornada
by adding peripheral devices, such as PC Cards,
CompactFlash Cards, and USB devices.

Using PC Cards and CompactFlash Cards

PC Cards and CompactFlash Cards provide a wide range of
additional functionality, such as additional memory, remov-
able storage, cellular modems, and network interface cards.
Many cards have been tested specifically for compatibility
with the HP Jornada H/PC. For a list of recommended
compatible devices, go to the Hewlett-Packard Web site at
www.hp.com/handheld.
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Install PC Cards and CompactFlash Cards according to the
card manufacturer’s instructions by inserting them into the
appropriate slot on your HP Jornada. You may also need to
install a software driver for a particular card. The software
drivers for Windows CE should be included with the card or
be available from the card manufacturer.

Many PC Cards use considerable power and can quickly drain your battery. Connect to AC
power while using PC Cards.

PC Card and CompactFlash memory modules appear as
folders in the My Handheld PC folder. The folder called
Storage card represents the first card you inserted, and the
folder called Storage card 1 represents the next card that
was inserted.

Connecting USB devices

USB devices connect to the Universal Serial Bus (USB) port
on your HP Jornada and typically include such peripherals
as mice or pointing devices, keyboards, and joysticks. When
connecting a USB device, you will need to install the software
driver(s) provided by the device manufacturer, and  the USB
port on your HPÊJornada needs to be enabled.
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To enable the USB port

1. Install the USB device driver(s) provided by the
device manufacturer.

2. Plug the USB device into the USB host (port).

The USB port will be automatically enabled. When the USB
port is enabled, the USB icon is displayed in the status area
of the taskbar.

USB devices use considerable power and can quickly drain your batteries. Unplug the USB
device when you are not using it.

Fine-tuning performance
This section offers information about tailoring your
HPÊJornada to match your working style. As on your desktop
PC, use Control Panel to change most of your HPÊJornada
options.

To open Control Panel

1. On the Start menu, point to Settings, and then
click Control Panel.

Double-click any of the icons in Control Panel to explore the
options for that feature. Specific Control Panel options are
described below.

USB host
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Setting general options

The following control panels enable you to set general options
for using your HP Jornada. For more information about a
particular control panel, see the Settings topic in online Help.

• Display—The Display control panel allows you to set the
background image and the appearance of your Windows
CE desktop.

• Keyboard—The Keyboard control panel allows you to set
options for how fast characters repeat when you hold down
a key on your HP Jornada keyboard.

• Owner—The Owner control panel allows you to store
personal information, such as your name and address, and
to choose whether to display this information each time
you turn on your HP Jornada.

• Password—The Password control panel allows you to
protect your HP Jornada with a password. You can choose
to be prompted to enter the password each time you turn
on your HP Jornada.

• Regional Settings—The Regional Settings control panel
allows you to set the format for time, date, numbers, and
currency based on your geographic region. Choose from
preset schemes or set individual options.

• System—The System control panel displays information
about the hardware and software configuration and
enables you to adjust the allotment of program memory
and storage memory.

• Volume & Sounds—The Volume & Sounds control panel
allows you to set the speaker volume and turn on and off
the sounds associated with different system events. You
can save your options as a sound scheme, just as you do
with Windows 95.
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• World Clock—The World Clock control panel allows
you to set the system time, set alarms and reminders,
and select your Home and Visiting cities. World Clock
also displays almanac information, such as the nearest
airport, sunrise and sunset times, and travel distance
between selected cities.

To open the World Clock control panel quickly, double-click the clock in the status area of
the taskbar.

Using the HP hot keys application
The HP hot keys give you one-key access to the programs
or documents you use most. With the HP hot keys applica-
tion, you can configure the HP hot keys to open any pro-
gram or file on your HP Jornada.

To start the HP hot keys application

1. On the Start menu, point to Programs, point to
HP Utilities, and click HP hot keys.

Customizing the HP hot keys
When you start the HP hot keys application, the current
hot key assignments are displayed in a list. The default key
assignments correspond to the program icons printed on
the HP hot keys, the top row of keys on the HP Jornada
keyboard.

To assign a program or file to a hot key

1. Start the HP hot keys program.

2. In the list, select the hot key you want to change.

3. Under Assign to, select a program from the drop-
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down list.
–or–
Click Browse to select a program or file
that is not in the list.

Restoring default hot key assignments
Your custom hot key assignments replace the default key
assignments; however you can also use the HP hot keys
application to quickly restore the defaults, which correspond
to the icons printed on the keys themselves.

To restore default key assignments

1. Start the HP hot keys application.

2. Click Restore defaults.

Using HP settings

The HP settings application allows you to change or adjust
important settings and allows you to quickly check the
status of constantly changing information about your
HPÊJornada, such as available memory and battery power.
It also allows you to set the password delay feature for
added security.

To open HP settings

1. On the Start menu, point to Programs, point to
HP Utilities, and then click HP Settings.
–or–
Press the HP settings hot key.
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Setting brightness, contrast, and volume

The Settings tab includes slider controls for brightness,
contrast, and volume, and a check box that mutes all
system sounds. Move the sliders to adjust the settings to a
comfortable level.

Click the speaker icon to switch to the Volume & Sounds control panel.

Changing HP settings profiles

Your HP Jornada has four preset HP settings profiles:
Indoors, Outdoors, Power saving, and My settings. You can
launch any profile by selecting the radio button associated
with it. You can also adjust any of the settings in any
profile to suit your preference.

Settings profiles Battery status

Volume, brightness,
and contrast sliders

Speaker mute

Speaker icon
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To change profiles

1. On the Start menu, point to Programs, point to
HP Utilities, and then click HP Settings.
–or–
Press the HP settings hot key.

2. On the Settings tab, select the radio button of the
profile you want to change.

3. Adjust sound, brightness, and contrast sliders to
your preference. Your new settings are saved auto-
matically.

4. Click OK.

Displaying power and memory information

The Settings tab also displays the status of your main
battery. The Memory tab shows the available PC Card
memory, the program memory, and the storage memory.

Setting the password delay timer

If you have set a Windows CE password, the Password
tab lets you set a timed delay before the password is
activated. By using the password delay, you can ensure
that you do not have to re-enter your password every time
your HP Jornada auto-suspends.

To set the password delay

1. On the Start menu, point to Programs, point to
HP Utilities, and then click HP Settings.
–or–
Press the HP settings hot key.

2. On the Password tab, under Activate Password
Protection, select After suspending for, and
then type the number of minutes or select a num-
ber from the list.
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If you have not set a password, click Set Password to switch to the Password
control panel.

Adjusting the HP Jornada touch pad
The HP Jornada touch pad replaces the mouse as a naviga-
tion and pointing device. The touch pad buttons act as the
primary and secondary (left and right) mouse buttons. In
addition, the touch pad can be used as a drawing tablet for
use with Microsoft InkWriter®.

The HP Jornada touch pad control panel enables you to set
options commonly associated with the mouse or other point-
ing device. It also lets you set special features unique to the
HP Jornada touch pad, such as settings that remind you to
take a short break.

To open the HP touch pad control panel

1. On the Start menu, point to Programs, point to
HP Utilities, and then click HP touch pad.

Prolonged use of the touch pad can put stress on your fin-
gers, hands, and wrists. To reduce the risk of fatigue or
stress from using the touch pad, the HP Jornada touch pad
surface is very sensitive and requires only slight pressure
from your fingertips.

For information about the causes and prevention of repetitive strain injuries (RSI), see
Appendix A.

Scheduled breaks

Frequent breaks can significantly decrease fingertip and
wrist fatigue. Use the Short Breaks tab of the HP touch
pad Properties dialog box to remind yourself to take a
short break from the keyboard after a set number of minutes

Chapter7.p65 0109 2/4/99, 4:15 PM134



Chapter 7 | Customizing your HP Jornada | 135

or a set number of clicks on the touch pad. Select one or
more of these options, and then select the interval from the
drop-down lists. You can set the reminder to play a sound
or display a custom message to signal that it is time for a
break.

Tap and drag behavior

Use the Touch pad tab to set properties of the HPÊJornada
touch pad. For example, you can set it so that you can simply
tap the touch pad rather than click the primary button.

Touch pad options

When you are typing, you may find it comfortable to rest
your wrists on the edge of the keyboard. You can automati-
cally disable the touch pad when you type, so you can rest
your wrists on the touch pad without inadvertently moving
the cursor or triggering a click.

To disable the touch pad

1. On the Touch pad tab of the HP touch pad
Properties dialog box, select Disable touch pad
when typing.

2. Adjust the slider to set the interval after which
the touch pad is reactivated.

Managing battery power
Because the data and files you save on your HPÊJornada are
stored in RAM, it is extremely important that you maintain
a continuous power supply to your HPÊJornada at all times.
If your HPÊJornada runs out of power, all information you
have entered will be lost. The WindowsÊCE operating
system and programs are stored in ROM and cannot be
erased; however, any programs you have added and custom
settings in existing programs will be lost.
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HP Jornada allows you to run on AC power using the AC
adapter or to run on battery power for convenience and
portability. HP Jornada uses two types of batteries. The
main battery, an “intelligent” rechargeable lithium-ion
battery pack, supplies power whenever your HPÊJornada is
not connected to AC power. Under normal circumstances, the
main battery will provide up to 10 hours of continuous use
without recharging.

The backup batteries protect your data when the main
battery runs down. The two coin-sized, lithium-ion backup
batteries do not provide enough power to operate your
HPÊJornada. They are intended only to protect your data
until the main battery is recharged. When the main battery
is very low, your HP Jornada will shut down, and you will be
unable to restart it until you charge the battery or connect to
AC power.

The battery icon in the status area of the taskbar indicates
whether the HP Jornada is operating on AC or battery power
and displays the status of the main battery.

Icon Indicates

Running on AC power

Running on battery power,
main battery power low

Backup battery power low

Backup battery power very low

Battery charging

Chapter7.p65 0109 2/4/99, 4:15 PM136



Chapter 7 | Customizing your HP Jornada | 137

You should respond immediately when a message warning of low battery power is
displayed. When the main battery power is low, simply connect the HP Jornada to AC
power to recharge. When the backup battery power is low, the backup batteries must be
replaced as soon as possible. It is recommended that you back up your data and run the
HP Jornada only on AC power until you have replaced the backup batteries.

For procedures on charging the main battery or replacing the
backup batteries, see the Setting up your HPÊJornada
section in chapter 2.

Using the Power control panel

Use the Power control panel to check the power level of the
main battery and backup batteries, as well as to set certain
options that will improve battery life.

Power Status tab

The Power Status tab displays information about the
current state of your batteries. This information helps you
determine how long you can operate your HP Jornada before
needing to recharge the battery.

The power level of the main battery is displayed as a percent-
age of full power and in terms of how many hours (estimated)
remain before the battery must be recharged. When
approximately 30 minutes or less of battery time remain,
the low battery icon is displayed in the Windows CE
taskbar.

The power level of the backup batteries is indicated as
Good, Low, or Very Low power. When the backup battery
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power is very low, you should replace the backup batteries
as soon as possible.

Power Saving tab

The Power Saving tab enables you to set certain options
that directly affect the life of the main battery:

• Auto-Suspend—Triggers HP Jornada to auto-suspend
operation after a period of continuous idle time. You can
select to auto-suspend while operating on either battery
or AC power, and you can specify the amount of idle
time in minutes.

• Dimming—Dims the display after a period of continu-
ous idle time. You can specify the amount of time in
seconds.

Conserving battery power

Under normal circumstances, the HP Jornada Standard
Battery should provide up to 10 hours of continuous use;
however, certain tasks require more battery power and
deplete the main battery faster. Follow the tips below to
maximize battery life.

• Reduce the brightness of the display. Compensate
for low light by increasing the contrast. (See the Using
the HP settings application section in this chapter.)

• Shorten auto-suspend time. Use the Power control
panel to set the length of continuous idle time before
your HP Jornada auto-suspends. Press the On/Off key
or click Suspend on the Start menu to turn off your
HP Jornada when it is not in use, even for a short time.

• Always use AC power when connecting your
HPÊJornada to your desktop PC. Note that your
HPÊJornada will not auto-suspend while it is connected,
so you must be careful not to allow the batteries to
run down.
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• Turn off sounds. Use the HP Jornada settings applica-
tion to mute the HP Jornada speaker, or use the Sound
& Volume control panel to turn on only the most neces-
sary system sounds.

• Set the screen to dim automatically after a short
time. Use the Power control panel to set the auto-
dimming feature.

• Connect to AC power when using an external
monitor.  Using an external monitor consumes
considerable power and can drain your battery.

• Avoid using PC Cards while on battery power.
Some PC Cards (especially PC Card modems) use
considerable power and will quickly drain your battery.

• Disconnect USB device when not in use. USB
devices use considerable power and will quickly drain
your battery. (See the Adding peripherals section in
this chapter.)
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If you encounter difficulties while using your HP Jornada
820 or 820e Handheld PC (H/PC), this chapter will help you
find answers. If you need information about troubleshooting
Microsoft® Windows® CE Services, click Windows CE
Services Help Topics on the Help menu in the Mobile
Devices window.

The information in this chapter will help you:

• Troubleshoot basic problems

• Troubleshoot problems with remote connections

• Troubleshoot problems with the display

• Troubleshoot problems connecting by infrared

• Reset your HP Jornada

Chapter8.p65 0108 2/4/99, 4:14 PM141



142 | HP Jornada H/PC User’s Guide

Troubleshooting basic problems
If you have a specific problem, review the information
below to see if you can find the answer quickly. Or, visit the
HPÊJornada Web site at www.hp.com/handheld for current
information about common difficulties.

Problem Diagnosis / Remedy

HP Jornada does Battery power is too low to run device.
not turn on when Connect to AC power, and then turn on
not connected to your HP Jornada. (Charge the battery
AC power. regularly to avoid running out of battery

power.)

Battery runs out You are using your HP Jornada in ways
of power that drain the batteries quickly.
very quickly. See the Managing battery power

section in chapter␣ 7.

HP Jornada does The HP Jornada is designed to stay on
not auto- while connected to a computer.
suspend when This is the correct behavior. No action
connected to a is needed.
desktop PC
or when using
the modem.

HP Jornada Batteries are too low to run device. When
automatically a critically low battery-power condition is
shuts down. encountered, the HP Jornada initiates a

safety shutdown. Connect to AC power
and charge the main battery. Do not
remove the backup batteries before
charging the main battery.

HP Jornada does HP Jornada is locked up. Connect the
not turn on when HP Jornada to external power, and
connected to perform a soft reset. (See the Resetting
AC power. section in this chapter.)

(Caution: You may lose any unsaved data
when performing a soft reset.)
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Problem Diagnosis / Remedy

HP Jornada locks up HP Jornada is  locked up. Connect to AC
when running power, and perform a soft reset. (See the
applications. Resetting section in this chapter.)

Note: Check battery power regularly to
ensure that the main battery is not
running low on power.

HP Jornada does The display contrast is too light. Press
not turn on or  to increase contrast. (For more
display appears to information, see the Setting up your HP␣ Jornada
be off, even though  section in chapter 2.)
power is on.

HP Jornada There is insufficient program memory or
runs very slowly. the memory needs to be refreshed.

To increase program memory
1. Delete any unnecessary files.
2. Close all applications.
3. On the Start menu, point to

Settings, and then click Control Panel.
Double-click the System icon.

4. On the Memory tab, adjust the
memory slider to increase the amount
of program memory.

To refresh the memory
1. Save your data.
2. Close all applications.
3. Perform a soft reset. (See the Resetting

section in this chapter.)

Insufficient HP Jornada has run out of program
memory error memory for the application.
occurs when To increase program memory
running an 1. Delete any unnecessary files.
application. 2. Close all applications.

3. On the Start menu, point to Settings,
and then click Control Panel.
Double-click the System icon.

4. On the Memory tab, adjust the
memory slider to increase the amount
of program memory.
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Problem Diagnosis / Remedy

HP Jornada does PC Card is not inserted properly or
not detect PC Card. drivers are not installed on your

HP Jornada. Remove and re-insert the
PC Card correctly.  If this does not fix the
problem, check the documentation for the
PC Card for information on installing
drivers on the HP Jornada.
(For more information about compatible
PC Cards, see the HP Jornada
Accessories page at www.hp.com/handheld.)

HP Jornada will not The sync cable is not connected properly to
establish a the PC or the HP Jornada or communications
connection with a are not configured correctly.  Reconnect
desktop PC. the cable correctly or see Windows CE

Services Help for more information.

Web pages are not
displayed according
to the options you set
in Pocket Internet
Explorer

Pressing the Pocket
Internet Explorer hot
key does not launch
the program

Sending and receiving
files via infrared does
not work

Unable to dial out
using the modem

If you set up the Web service using HP
dialup, the options you set in HP dialup
determine the way Web pages are
displayed. Options you change in Pocket
Internet Explorer affect only the current Web
session; these changes are not saved.

My Handheld PC or Windows Explorer may
be open. Pressing the Pocket Internet
Explorer hot key will switch between any
open folders (e.g., Control Panel, My
Documents, or My Handheld PC) and Pocket
Internet Explorer. This is the correct behavior.

The HP Jornada cannot send files to or
receive files from a Windows CE 1.0 device
via infrared. Windows␣ CE 1.0 does not
support the FastIR  file transfer protocol used
by your HP Jornada.

In certain countries you may have to clear
the Wait for dial tone before dialing check box.
See the Troubleshooting problems with remote
connections section in chapter 8 of the User’s
Guide.
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Unable to send e-mail
messages from Inbox

HP viewer seems to
launch slowly

After performing a soft
reset, the touch pad or
USB device does not
work

HP Jornada locks up

The display is
distorted on an
external monitor or
projector

Message header is too big. If your address
list exceeds 32 KB, Inbox is unable to send
the message.

Contacts, Calendar, and Tasks databases
are very big. Limit the size of your
databases by synchronizing only selected
contacts, appointments, and tasks. For more
information, see the Synchronizing selected data
section in chapter 4 of the User’s Guide.

You must disconnect the USB device before
performing a soft reset. Disconnect the USB
device, perform a soft reset, and then
reconnect the USB device again.

Program memory is low. Connect to AC
power, and perform a soft reset (see the
Resetting section in chapter 8 of the User’s
Guide). You can also use the System control
panel to increase the allocated program
memory. For more information, see the
Settings topic on online help.

Some VGA projectors may have a different
refresh timing than your␣ HP␣ Jornada.  To
optimize the display, install Hpvoutst.exe
from the HP␣ Jornada compact disc to your
HP Jornada. For details installing
Hpvoutst.exe, refer to the Readme.file on
the compact disc or see the Adding software
section in chapter 7 of the User’s Guide.

Problem   Diagnosis / Remedy

Troubleshooting remote connections
This section offers troubleshooting help for trying to
connect your HP Jornada to other computers. For
problems communicating with your desktop, see
WindowsÊCE Services Help.
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Unable to dial out using the modem

• Verify that the modem is installed correctly
(model 820e only) and connected to the telephone line.

• If you are using the internal modem (model 820 only),
verify that you are using an analog telephone line.
(Most home telephone lines are analog, while most
office telephone lines are digital.)

• Verify that you have correctly set dialing properties for
this connection.

• Check to see if the modem is waiting for a dial tone.
To do this, on the Start menu, point to Programs,
point to Communication, and then click Remote
Networking. Select your connection, and then click
Properties on the File menu. In the Dial-Up
Connection dialog box, click Configure and then click
the Call Options tab. Verify that Wait for dial tone
before dialing is selected.

• Allow more time for the call to go through if you are
attempting to make an international call. On the
Call Options tab described in the previous step, clear the
Cancel the call if not connected within option or
increase the number of seconds allowed.

Able to dial out, but unable to make
a proper connection

• Verify that the network you are attempting to connect to
supports PPP (Point-to-Point protocol) or SLIP (Serial
Line Internet Protocol).

• Verify that you have the correct dialing location selected.
On the Start menu, point to Settings, click Control
Panel, and then double-click the Dialing icon. Make sure
that the location settings reflect your current location,
that the dialing pattern for the location is appropriate, and
that the local country and area code are correct.
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Connection is unreliable

• Make sure the modem is firmly seated and connected to
both your HP Jornada and the telephone jack.

• Disable call waiting. On the Start menu, point to
Settings, click Control Panel, and then double-click
the Dialing icon. Select Disable call waiting by
dialing and enter the disable code specified by your
telephone company.

Network connection is not listed
in the ActiveSync dialog box

• Close the dialog box, wait a few minutes, and try again.
• Reset your HP Jornada. (See the Resetting section in

this chapter.)

Infrared transfer between Windows CE–based
devices

If you are unable to transfer information between
WindowsÊCE–based devices by infrared, try the following.

• Transfer only one file, or no more than 25 contact cards,
at a time.

• Position the infrared ports so that they line up and are
less than 1Êmeter (3Êfeet) but more than 5Êcentimeters
(2Êinches) apart.

• Make sure nothing is blocking the path between the two
infrared ports.

• Adjust the room lighting. Some types of lighting inter-
fere with infrared communication. Try moving to a
different location or turning off some lights.
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Display
If you are having trouble viewing your data, here are some
suggestions.

Screen is blank

If your HP Jornada fails to respond when you briefly press
the On/Off key, try holding the button down for a full
second. If that does not work:

• Make sure your battery cover is locked and all expansion
slots are secured.

• Adjust the display contrast. On some devices, the screen
can darken or lighten to the point that it appears to be
turned off.

• Reset your HP Jornada. (See the Resetting section in
this chapter.)

• Recharge the main battery.

Screen is dark

Prolonged exposure to direct sunlight may cause your
HPÊJornada screen to temporarily darken. This is a normal
occurrence with LCD screens and is not permanent.

Resetting
Occasionally, you will need to reset your HP Jornada; for
example, you may reset after you restore data from your
desktop PC or when the operating system stops respond-
ing. There are two methods of resetting:

• Soft reset—A soft reset (also called “warm boot”) is
similar to restarting your desktop PC. It restarts the
operating system and preserves any saved data.

• Full reset—A full reset (also called “hard reset”) re-
stores your HP Jornada to its original state, erasing all
information you have entered.
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To ensure the safety of your information in case a full reset
is necessary, you should regularly back up your data to
your desktop PC (using Windows CE Services) or to a
CompactFlash or PC Card (using the HP Jornada backup
application). For more information on backing up data, see
the Backing up and Restoring data section in chapter 6.

Soft reset

Perform a soft reset after restoring data from a backup file
or when your HP Jornada appears to be “frozen” or “locked
up.”

When you perform a soft reset you will lose unsaved data in all open documents
or programs.

To perform a soft reset

1. Use a pen or a paperclip to press the Reset button
on the HP Jornada keyboard.

Reset button
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Full reset

Perform a full reset only when your HP Jornada does not
respond to a soft reset. A full reset will erase all data you
have entered, including all files, system settings, and
programs you have installed. If you have forgotten your
password, you will also need to perform a full reset.

Performing a full reset erases all files, programs, and appointments you have entered. You
can restore only data that has been backed up to your desktop PC or to a PC Card or
CompactFlash Card. (For more information, see the Backing up and restoring data
section in chapter 6.)

To perform a full reset

1. Disconnect the AC adapter from your HP Jornada.

2. Remove the main battery.

3. Remove the backup battery tray.

4. Wait at least 5 minutes, and then reinstall the
batteries and reconnect the AC adapter. (For more
information, see the Setting up your HPÊJornada
section in chapter 2.) Your HPÊJornada should turn
on automatically, and display the Windows CE
Welcome Wizard. For more information about this
wizard, see the Completing the Welcome Wizard
section in chapterÊ2.

5. Restore data to your HP Jornada from your most
recent backup file. For more information, see the
Backing up and Restoring data section in
chapterÊ6.
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Warranty, support,
and service

Limited one-year warranty
Your HP Jornada H/PC (models 820 and 820e) comes with a
limited one-year warranty.

What is covered

Your HP Jornada H/PC (models 820 and 820e) (except for the
coin-cell backup batteries, or damage caused by this battery)
and accessories are warranted by Hewlett-Packard against
defects in materials and workmanship for one year from the
date of original purchase. If you sell your unit or give it as a
gift, the warranty is automatically transferred to the new
owner and remains in effect for the original one-year period
beginning at the time of purchase. During the warranty
period, we will repair or, at our option, replace at no charge a
product that proves to be defective, provided you return the
product, shipping prepaid, to a Hewlett-Packard service
center. (Replacement may be made with a new or re-condi-
tioned device, or with a newer model of equal or better
functionality.)

This warranty gives you specific legal rights, and you may
also have other rights that vary from state to state, province
to province, or country to country.
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What is not covered

Backup batteries, and damage caused by the battery, are not
covered by the Hewlett-Packard warranty. Check with the
battery manufacturer about battery and battery leakage.

This warranty does not apply if the product has been dam-
aged by accident or misuse, or as the result of service or
modification by other than an authorized Hewlett-Packard
service center.

No other express warranty is given. The repair or replace-
ment of a product is your exclusive remedy. ANY OTHER
IMPLIED WARRANTY OR MERCHANTABILITY OR
FITNESS IS LIMITED TO THE ONE-YEAR DURATION
OF THIS WRITTEN WARRANTY. Some states, provinces,
or countries do not allow limitations on how long an implied
warranty lasts, so the above limitation may not apply to you.
IN NO EVENT SHALL HEWLETT-PACKARD COMPANY
BE LIABLE FOR CONSEQUENTIAL DAMAGES. Some
states, provinces, or countries do not allow the exclusion or
limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you.

Products are sold on the basis of specifications applicable at
the time of manufacture. Hewlett-Packard shall have no
obligation to modify or update products, once sold.
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Consumer transactions in Australia,
New Zealand and the United Kingdom
The preceding disclaimers and limitations shall not apply to
consumer transactions in Australia, New Zealand and the
United Kingdom, and shall not affect the statutory rights of
consumers.

For consumers in Australia

The above warranty terms and any other warranty state-
ment enclosed with this product, except to the extent lawfully
permitted, do not exclude, restrict, or modify and are in
addition to the statutory rights implied by the Trade Prac-
tices Act 1974 or any corresponding State or territory legisla-
tion applicable to the sale of this product to you. If you have
any queries about your rights, contact the Hewlett-Packard
Customer Care Center at 61-3-88778000.

For consumers in New Zealand

The above warranty terms or any other warranty statement
enclosed with this product, except to the extent lawfully
permitted, do not exclude, restrict or modify and are in
addition to the statutory rights implied by the Consumer
Guarantees Act 1993 applicable to the sale of this product to
you. If you have any queries about your rights contact the
Hewlett-Packard End User Support line at 0800-733547.
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Year 2000 warranty
Subject to all of the terms and limitations of the HP Limited
Warranty Statement provided with this HP Product, HP
warrants that this HP product will be able to accurately
process date data (including, but not limited to, calculating,
comparing, and sequencing) from, into, and between the
twentieth and twenty-first centuries, and the year 1999 and
2000, including leap year calculations, when used in accor-
dance with the Product documentation provided by HP
(including any instructions for installing patches or up-
grades), provided that all other products (e.g. hardware,
software, firmware) used in combination with such HP
product(s) properly exchange date data. The duration of the
Year 2000 warranty extends through January 31, 2001.

HP makes no representation or warranty respecting the
accuracy or reliability of information about non–HP prod-
ucts. Such information is provided by the manufacturers of
those products, and customers are urged to contact the
manufacturer directly to verify Year 2000 readiness.
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Customer     support
If you have questions that this User Guide does not answer
(after checking the contents and index), you can contact
Hewlett-Packard Worldwide Support and Services for
Handheld Products at the telephone numbers listed in the
following table. If your H/PC Pro requires service, contact
Hewlett-Packard for service information, shipping instruc-
tions, and out-of-warranty service charges before you send
your unit to HP for repair. In countries not listed in the
table, contact your Hewlett-Packard authorized dealer or
sales office.

Service

For diagnostic instructions and other service information,
contact one of the technical support numbers listed. Please
do not ship your unit for service without first contacting a
Hewlett-Packard office. If your unit qualifies for in-warranty
service, be ready to supply a dated proof of purchase.

In countries not listed in the following table, contact your
Hewlett-Packard authorized dealer or sales office.

Before you contact us for help, be sure to:

1. Review the manuals whenever possible.
2. Have the following information about the product:

• Model number

• Serial number

• Purchase date

3. Have your product ready to use. The support
personnel may ask you to run tests and other
operations.

4. Organize your question or problem. The more
detailed information you can provide, the quicker
the support personnel can help you.
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Web site

You can also obtain product information as well as tips and
hints on how to get more from your handheld product at our
worldwide Web site. This computer service is provided free of
charge; you pay only for telephone charges and Internet
service fees. To connect to this Web site from a computer via
the Internet, go to www.hp.com/handheld.
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Contacting Hewlett-Packard worldwide
You will be pleased to know that our commitment to
quality does not stop at the sale. Our worldwide customer
support network is available to give you personal telephone
service should you need it.

Argentina 54-1-7788380

Australia 61-3-88778000

Austria 43-6606386

Belgium (Dutch) 32-2-6268806

Belgium (French) 32-2-6268807

Canada 1-905-2064663

China 86-10-65645959

Czech Republic 420-2-61307310

Denmark 45-39-294099

Finland 358-20347288

France 33-1-43623434

Germany 49-1-805258143

Greece 30-1-6896411

Hong Kong 800-967729

Hungary 36-1-3430310

India 91-11-6826035

Indonesia 62-21-3503408

Ireland 353-1-6625525

Israel 972-9-9524848
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Italy 39-2-26410350

Japan 81-3-33358333

Korea 82-2-32700700

Malaysia 60-03-2952566

Netherlands 31-20-6068751

New Zealand 0800-733547

Norway 47-22-116299

Philippines 63-2-8673551

Poland 48-22-8659999

Portugal 351-1-4417199

Russia 7-095-9169821

Singapore 65-2725300

South Africa 27-11-4481140

Spain 34-91-7820109

Sweden 46-8-6192170

Switzerland 41-848-801111

Taiwan 886-2-7170055

Thailand 66-2-6614011

Turkey 90-212-2245925

UK 44-870-6083003

USA
Pre-sales Information 1-800-443-1254

(toll-free, no operator is available)
Support & Service 1-970-635-1000

Palmtops & Organizers (toll call)

All Customer Care Centers are available during office
hours. Pre-sales Information in the USA is available
24 hours per day, 7 days per week. Support & Service
in the USA can be contacted from 5 am to 5 pm Pacific
Time, Monday through Friday.

Warranty.p65 0108 2/4/99, 4:21 PM158

TelephoneCountry/Region



     | 159

Appendix A
Ergonomics

This chapterÊprovides guidance and hints to help you work in
a comfortable and ergonomically low-risk environment. If you
experience pain or discomfort while using this or any other
equipment, you should stop working and review this chapter.
If the discomfort continues, stop using the equipment and
consult a doctor as soon as possible.

Setting up and using equipment
Some people experience physical discomfort while using
computers. Sometimes this discomfort leads to Repetitive
Strain Injury (RSI), also known as cumulative trauma
disorder or repetitive motion injury. Setting up and using
equipment properly can help minimize this discomfort.
Well-designed and adjusted equipment may not be suffi-
cient to eliminate all potential problems. How you perform
your computer activities is also important.
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What is RSI?
RSI is a type of injury caused by the irritation or inflamma-
tion of soft tissues such as muscles, nerves, or tendons. In
extreme cases, this irritation can lead to permanent tissue
damage. RSI has been a documented problem for workers
performing specific tasks such as assembly line work,
meatpacking, sewing, playing musical instruments, and
working with a computer. It may also result from other
activities, such as tennis.

What causes RSI?
RSI is caused by certain demanding activities that exceed the
body’s ability. Common factors associated with RSI include
too many uninterrupted repetitions of an activity or motion,
performing an activity in an awkward or unnatural posture,
maintaining static posture for prolonged periods, failing to
take frequent short breaks, and stress. Certain medical
conditions, such as rheumatoid arthritis and diabetes, may
contribute to RSI.

RSI symptoms
By following the guidelines on proper setup and use of
equipment and work environment, the risk of developing
RSI can be minimized. However, if you experience any
discomfort, seek professional advice immediately. Typi-
cally, the earlier a problem is diagnosed and treated, the
easier it may be to resolve.
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Avoiding RSI
Recent literature suggests that there may be a relationship
between injury to soft tissues, especially in the hands and
arms, and the prolonged use of keyboards or other equip-
ment requiring repeated motion of the hands and forearms.
Literature also suggests that there are many other risk
factors that may increase the chances of such soft-tissue
injury. You can minimize the risk of suffering from RSI by
following the guidelines detailed in this chapter.

Setting up your working environment
You must have enough space to move around and vary your
position. To avoid eye strain, the ceiling, walls, and floors
should have a medium level of reflectance (approximately
75 percent of ceiling reflectance, 40 percent of wall reflec-
tance, and 30 percent of floor reflectance). Try to avoid
excessive contrast between the screen and its surround-
ings. The work environment should be as quiet and distrac-
tion-free as possible, with background noise below 58ÊdBA.
Where possible, relative air humidity should be in the
range of 40 to 60 percent. Recommended room temperature
is 19 to 23ÊºC (66 to 73ÊºF). If possible, adjust the tempera-
ture to a comfortable level. The workplace should be well
ventilated.

Pay attention to your posture; relax your shoulders and
keep your wrists straight. This is easier when your key-
board can be positioned right under your hands while
bending your elbows at 90º. Pull your chin in to look down,
and try to lean back in the chair. The backrest should
support you in the hollow of your back.
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Reducing eye strain
Have your eyes checked on a regular basis and ensure your
eyeglass prescription is suitable for working on a computer
screen. Look away from the screen from time to time. Focus
on distant objects briefly. Blinking periodically helps to
lubricate the eyes.

Preventing muscle stiffness
Avoid holding your muscles tense for long periods of time.
Keep your fingers and body relaxed. Changing tasks
frequently helps prevent muscle stiffness. Alternating
between typing, writing, filing, and moving around in your
work environment helps to keep muscles loose.

Taking frequent short breaks
When you are required to work on your computer for pro-
longed periods of time, take short breaks frequently. As a
general rule, a 5- and 10-minute break every hour is a good
idea. It is better to take short breaks frequently than longer
breaks less frequently. Data shows that people who work for
long periods of time without a break are more prone to injury.
Occasionally stretch the muscles in your hands, arms,
shoulders, neck, and back. You should stretch at least once
an hour.

Appendix.p65 0108 2/4/99, 4:05 PM162



Ergonomics | 163

Using the HP Jornada touch pad
Prolonged use of the touch pad can put stress on fingers,
hands, and wrists. To reduce the risk of fatigue or stress
while using the touch pad, we have included the HPÊJornada
short breaks application, and we have installed a very
sensitive touch pad that requires only low pressure for
activation. These additions reduce the risk of soreness and
fatigue due to friction between your finger and the touch pad.

The HP Jornada short breaks application periodically alerts
you to take a short break and offers a variety of settings that
will aid you in the use of the touch pad. Use the HPÊJornada
touch pad control panel to change the default settings to fit
your own requirements. For more information, see chapterÊ7.
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Glossary

AC adapter  A connector that provides external power (not
battery power) to your HPÊJornada. For information about
installing and using the AC adapter, see the Setting up
your HP Jornada section in chapter 2.

ActiveSync  A feature of Windows CE Services that man-
ages data synchronization between your HPÊJornada and
desktop PC. You can specify the type of data you want to
synchronize.

backup file  A duplicate copy of your HP Jornada files and
data that is stored on your desktop PC or on a PC Card.
This file does not include your HP Jornada settings and
information stored in ROM, such as factory-installed
software. Use your backup file to restore your HPÊJornada
to its previous state if your device data is damaged or
destroyed or if you have performed a full reset.

cache  A special high-speed storage mechanism that saves
temporary copies of Web pages and other file types as your
view them. Your computer can quickly display Web pages
you have recently visited, because Pocket Internet Ex-
plorer can open them from cache instead of having to load
them again from the Web. Increasing the space designated
for your cache folder increases how quickly recently visited
files are displayed, but decreases the amount of space
available for other files on your HPÊJornada. You can
choose to empty your cache upon exiting Pocket Internet
Explorer. This saves space on your device.
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cookies  A packet of messages a Web server passes to your
Web browser. When you enter a Web site that uses
cookies, you may be asked to fill out a form with informa-
tion such as your name and interests. This information is
passed to your Pocket Internet Explorer browser as a
cookie (in the form of a text file called cookie.txt). The next
time you visit that Web site, your Pocket Internet
Explorer will pass the cookie back to the Web server, and
the server will use this information to present you, for
instance, with custom Web pages filled with information of
interest to you. For example, instead of being presented
with a generic welcome page, you might receive a welcome
page with your name on it.

dial-up connection  A connection between your
HPÊJornada and another computer by modem. You can
have a dial-up connection with an ISP, a network, or with
a modem attached to a PC.

direct connection  A connection between your HPÊJornada
and another computer by means of the sync cable or IR port.

DNS  Domain Name System (DNS) is an Internet service
that translates domain names into IP addresses. For
example, the domain name www.jornada.com might
translate as 198.125.247.4.

full reset  To return your HP Jornada to its original
state by removing all power, thereby erasing all files
and data you have saved. For more information, see
the Resetting section in chapter 8. (Also called
“hard reset.”)

Internet service provider (ISP)  A company that provides
access to the Internet.
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IP  Internet Protocol (IP) specifies the format of packets, also
called datagrams, and the addressing scheme of the Web.
Much like a postal system, IP allows you to address a
package and drop it into the system, but your package is
not delivered instantly to your recipient. The packets are
simply delivered to a server until the recipient downloads
them by logging onto the ISP server.

LAN  A local area network (LAN) is a group of computers,
usually in close proximity (either in the same building or
in buildings in close proximity), that are linked together to
share files and exchange data.

NIC  A network interface card (NIC) is a card that is
installed in a computer so that it can be connected to a
network. Network interface cards can provide a dedicated,
full-time connection to a network.

ODBC databases  Open DataBase Connectivity (ODBC), is
a standard database access method. The goal of ODBC is
to make it possible to access any data from any applica-
tion, regardless of which database management system is
handling the data.

partnership  An established relationship between your HP
Jornada and your PC for the purpose of synchronizing and
transferring data. Your HP Jornada can have partner-
ships with up to two desktop computers.

PCT  Private Communication Technology (PCT) is a protocol
that maintains the security and integrity of Internet
communications by using encryption, authentication, and
message-authentication codes. The protocol is application
independent, and is used by Web browsers and e-mail
clients to send data via the Internet. PCT is able to
negotiate encryption keys as well as authenticate a server
before data is exchanged by the higher level application.
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POP  Post Office Protocol (POP) was the first protocol
used to retrieve e-mail from a mail server. Most e-mail
applications (sometimes called e-mail clients) use the POP
protocol, although some may use the newer IMAP
(Internet Message Access Protocol).

PPP  Point-to-Point Protocol (PPP) is the default method
your HP Jornada uses to communicate with the ISP
network server.

RAS (Remote Access Service) account   A network
account that enables your HP Jornada to access your
Windows NT network remotely .

remote connection   A connection between your
HPÊJornada and a remote computer or server.

reset  A process that either causes your HP Jornada to
restart (soft reset) or causes all data stored in RAM to
be erased (full reset). For more information, see the
Resetting section in chapter 8.

restore  To return your device to the state it was in when
last backed up. This involves copying your backup data to
your HP Jornada.

SLIP  Serial Line Protocol (SLIP) is an older and simpler
protocol than PPP. Connecting to the Internet via SLIP is
very similar to connecting via PPP.

soft reset  The process of restarting your HP Jornada and
reinitializing the Windows CE operating system. Perform-
ing a soft reset will erase any unsaved data in open
documents, but will preserve data that has been saved.
(Also called “warm boot.”)
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Important: Please carefully read this License Agreement
before operating the equipment. Rights to the software are
offered only on the condition that the Customer agrees to
all terms and conditions of the License Agreement. Oper-
ating the equipment indicates your acceptance of
these terms and conditions. If you do not agree to the
License Agreement, you may return the unopened package
for a full refund. In return for payment of the applicable
fee, HP grants the Customer a license to the software, until
terminated, subject to the following:

Use:

• Customer may use the software on any one computer.

• Customer may not reverse, assemble, or decompile the
software.

Copies and adaptations:

• Customer may make copies or adaptations of
the software:
• for archival purposes, or

• when copying or adaptation is an essential step in the
use of the software with a computer so long as the
copies and adaptations are used in no other manner.

• Customer has no other rights to copy unless Customer
acquires an appropriate license to reproduce which is
available from HP for some software.

HP software product
license agreement
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• Customer agrees that no warranty, free installation, or
free training is provided by HP for any copies or adapta-
tions made by Customer.

• All copies and adaptations of the software must bear the
copyright notice(s) contained in or on the original.

Ownership:

• Customer agrees that they do not have any title or
ownership of the software, other than ownership of the
physical media.

• Customer acknowledges and agrees that the software is
copyrighted and protected under the copyright laws.

• Customer acknowledges and agrees that the software
may have been developed by a third-party software
supplier named in the copyright notice(s) included with
the software, who shall be authorized to hold the Cus-
tomer responsible for any copyright infringement or
violation of this License Agreement.

Transfer of rights in software:

• Customer may transfer rights to the software to a third
party only as part of the transfer of all their rights and
only if Customer obtains the prior agreement of the third
party to be bound by the terms of this License Agree-
ment.

• Upon such a transfer, Customer agrees that their rights
to the software are terminated and that they will either
destroy their copies and adaptations or deliver them to
the third party.

• Transfer to a U.S. government department or agency or
to a prime or lower tier contractor in connection with a
U.S. government contract shall be made only upon prior
written agreement to terms required by HP.
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Sublicensing and distribution: Customer may not
sublicense the software or distribute copies or adaptations
of the software to the public in physical media or by tele-
communication without the prior written consent of HP.

Termination: HP may terminate this software license for
failure to comply with any of these terms, provided HP has
requested Customer to cure the failure and Customer has
failed to do so within thirty (30) days of such notice.

Updates and upgrades: Customer agrees that the soft-
ware does not include updates and upgrades that may be
available from HP under a separate support agreement.

Export clause: Customer agrees not to export or re-export
the software or any copy or adaptation in violation of the
U.S. Export Administration regulations or other applicable
regulations.

HP shrink-wrap license terms

The following License Terms govern your use of the
accompanying Software unless you have a separate
signed agreement with HP.

License grant: HP grants you a license to use one copy
of the Software. “Use” means storing, loading, installing,
executing or displaying the Software. You may not modify
the Software or disable any licensing or control features of
the Software. If the Software is licensed for “concurrent
use”, you may not allow more than the maximum number
of authorized users to use the software concurrently.

Ownership: The Software is owned and copyrighted by
HP or its third party suppliers. Your license confers no title
to, or ownership in, the Software and is not a sale of any
rights in the Software. Third party suppliers to HP may
protect their rights in the event of any violation of these
License Terms.
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Copies and adaptations: You may only make copies or
adaptations of the Software for archival purposes or when
copying or adaptation is an essential step in the authorized
Use of the Software. You must reproduce all copyright
notices in the original Software on all copies or adaptations.
You may not copy the Software onto any public network.

No disassembly or decryption: You may not disas-
semble or decompile the Software unless prior written
consent is obtained from HP. In some jurisdictions, consent
from HP may not be required for limited disassembly or
decompilation. Upon request, you will provide HP with
reasonably detailed information regarding any disassem-
bly or decompilation. You may not decrypt the Software
unless decryption is a necessary part of the operation of
the Software.

Transfer: Your license will automatically terminate upon
any transfer of the Software. Upon transfer, you must
deliver the Software, including any copies and related
documentation, to the transferee. The transferee must
accept these License Terms as a condition to the transfer.

Termination: HP may terminate your license upon notice
for failure to comply with any of these License Terms.
Upon termination, you must immediately destroy the
Software, together with all copies, adaptations, and merged
portions in any form.

Export requirements: You may not export or re-export
the Software or any copy or adaptation in violation of any
applicable laws or regulations.
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U.S. government restricted rights: The Software and
Documentation have been developed entirely at private
expense. They are delivered and licensed as “commercial
computer software” as defined in DFARS 252.227-7013
(Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS
252.227- 7014 (Jun 1995), as “commercial item” as defined
in FAR 2.101 (a), or as “Restricted computer software” as
defined in FAR 52.227-19 (Jun 1987) (or any equivalent
agency regulation or contract clause), whichever is appli-
cable. You have only those rights provided for such Soft-
ware and Documentation by the applicable FAR or DFARS
clause or the HP standard software agreement for the
product involved.
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